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This document details the Lab Protocol for testing the items listed in the following table. 

This method file describes measurements of UAS_K.  

File 
Name 

Variable 
Name SAS Label (and SI units) 

UAS_K 

URXUAS3  Urinary Arsenous Acid (µg/L) 

URXUAS5 Urinary Arsenic Acid (µg/L) 

URXUAB  Urinary Arsenobetaine (µg/L) 

URXUAC Urinary Arsenocholine (µg/L) 

URXUDMA Urinary Dimethylarsinic Acid (µg/L) 

URXUMMA Urinary Monomethylarsonic Acid (µg/L) 
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1. CLINICAL RELEVANCE AND TEST PRINCIPLE  

a. Clinical Relevance 

People encounter arsenic in many chemical forms that vary in toxicity. The most toxic of the 
naturally-occurring arsenic compounds are inorganic forms of arsenic and their monomethylated 
metabolites (1). Less toxic are the organic arsenic compounds (2-5). Exposure to inorganic 
arsenic can result in a variety of adverse health effects, such as skin disorders, nerve impairment, 
cancer of the liver, bladder, kidneys, prostate, and lungs, and even death from large doses (6, 7). 
People may be exposed to inorganic arsenic through activities such as drinking water 
contaminated from geological sources (8-14) or occupational exposure (15-19), especially 
breathing air contaminated with sawdust or smoke from wood treated with chromated copper 
arsenic preservatives (20-25). Organic arsenic compounds are generally less toxic and may be 
encountered by ingesting various types of fish, shellfish, or seaweed (26-31).  

The method described in this manual assesses arsenic exposure, as defined by exposure to 
individual arsenic species by analyzing urine through the use of high performance liquid 
chromatography (HPLC) coupled to inductively-coupled plasma dynamic reaction cell-mass 
spectrometry (ICP-DRC-MS). Urine is analyzed because urinary excretion is the major pathway 
for eliminating arsenic from the mammalian body (32-34). This hyphenated method will provide 
accurate quantification of seven urinary arsenic species:  inorganic species - arsenite (valence III) 
and arsenate (valence V), their metabolites - monomethylarsonic acid (MMA) and dimethylarsinic 
acid (DMA), and organic forms of arsenic which include trimethylarsine oxide (TMAO), 
arsenocholine (AC), and arsenobetaine (AB) (see TABLE 1-1).  

b. Test Principle 

The concentrations of arsenate [As(V)], arsenite [As(III)], MMA, DMA, TMAO, AC, and AB are 
determined by using a high performance liquid chromatography (HPLC) system to separate the 
species coupled to an ICP-DRC-MS to detect the arsenic species. This analytical technique is 
based on separation by anion-exchange chromatography (IC) followed by detection using 
quadrupole ICP-MS technology and includes DRC™ technology (35) which minimizes or 
eliminates many argon-based polyatomic interferences (36). Column separation is largely 
achieved due to differences in charge-charge interactions of each negatively-charged arsenic 
component in the mobile phase with the positively-charged quaternary ammonium groups bound 
at the column’s solid-liquid interface. Upon exit from the column, the chromatographic eluent goes 
through a nebulizer where it is converted into an aerosol upon entering the spray chamber. 
Carried by a stream of argon gas, a portion of the aerosol is transported through the spray 
chamber and then through the central channel of the plasma, where it is heated to temperatures 
of 6000-8000°K. This thermal energy atomizes and ionizes the sample. The ions and the argon 
enter the mass spectrometer through an interface that separates the ICP, which is operating at 
atmospheric pressure (approximately 760 torr), from the mass spectrometer, which is operating at 
approximately 10-5 torr. The mass spectrometer permits detection of ions at each mass-to-charge 
ratio in rapid sequence, which allows the determination of individual isotopes of an element.  
Once inside the mass spectrometer, the ions pass through the ion optics, then through the 
DRC™ and finally through the mass-analyzing quadrupole before being detected as they strike 
the surface of the detector.  The ion optics uses an electrical field to focus the ion beam into the 
DRC™. The DRC™ component is pressurized with an appropriate reaction gas and contains a 
quadrupole.  In the DRC™, elimination or reduction of argon-based polyatomic interferences 
takes place through the interaction of the reaction gas with the interfering polyatomic species in 
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the incoming ion beam.  The quadrupole in the DRC™ allows elimination of unwanted reaction 
by-products that would otherwise react to form new interferences.  

 

TABLE 1-1:  SPECIES OF ARSENIC  

Name Abbreviation Structural Formula pKa 

Arsenobetaine AB 
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2. SAFETY PRECAUTIONS 

Precautionary information that is important to protecting personnel and safeguarding 
equipment will be presented inside a box, such as this one, throughout the procedure 
where appropriate.  

 
Follow universal precautions. Wear gloves, a lab coat, and safety glasses while handling human 
blood, plasma, serum, urine or other bodily fluid or tissue. Operators of this method must take the 
Hazardous Chemical Waste Management for CDC Workers course upon initial hire and yearly 
refreshers thereafter.  Place disposable items (e.g., pipette tips, autosampler tubes, and gloves) 
that come in contact with human biological fluids, such as urine, in a biohazard autoclave bag.  
Keep these bags in appropriate containers until they are sealed and autoclaved. When work is 
finished, spray all work surfaces where human biological fluids were handled with a broad 
spectrum disinfectant or other appropriate disinfectant. Dispose of all diluted biological samples in 
a biohazard autoclave bag at the end of the analysis according to CDC/DLS guidelines for 
disposal of hazardous waste. 

PerkinElmer® provides safety information that must be read before operating the ICP-MS 
instrument. This information is found in the PerkinElmer® NexION® 300D ICP-DRC-MS System 
Safety Manual. Possible hazards include ultraviolet radiation, high voltages, radio-frequency 
radiation, and high temperatures. 

Handle acids and bases with extreme care; they are caustic and toxic. Reagents used in this 
study include those listed in Section 5. Safety Data Sheet documents (SDS) for these chemicals 
are readily accessible as hard copies in the lab. If needed, SDS for other chemicals can be 
viewed at http://www.ilpi.com/msds/index.html or through CDC networked computers at  
http://intranet.cdc.gov/olss/ .  
 

Caution! 
Exercise caution when handling and dispensing concentrated nitric acid.  Always 
remember to add acid to water.  Nitric acid is a corrosive chemical that is capable of 
severe eye and skin damage.  At a minimum, wear powder-free gloves, a lab coat, and 
safety glasses.  If any part of the body is exposed to nitric acid, quickly wash the exposed 
area with copious quantities of water for at least 15 minutes and refer to the SDS for full 
information. 

3. DATA SYSTEM MANAGEMENT 

To maintain the integrity of sample and analytical data generated by this method, eliminate hand 
entry of sample identifiers (IDs) or analytical results whenever possible. When this is not possible, 
proofread all transcribed data.  Regularly back up the ICP-MS computer’s hard drive. It is 
recommended that a defragmentation program be run on the computer’s hard drive on a periodic 
basis.  

a. Data Entry and Transfer 

Enter sample identifiers into the ICP-DRC-MS computer software either by using barcode 
scanners to scan the ID directly from the vials or queue sheets or by copying the IDs from an 
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Excel file with sample IDs exported directly from the Laboratory Information Management System 
(LIMS).  This will eliminate transcription errors and speed up sample processing.  If hand entry of 
a sample ID is necessary, proofread transcribed data after entry.  Transfer data electronically 
when reporting or moving data to other computerized data-handling software programs or storage 
locations. 

b. Routine Computer Hard Drive Maintenance 

Defragment the computer hard drive by using software such as Microsoft Windows® Disk 
Defragmenter (located in Start > Programs > Accessories > System Tools) or an equivalent 
program to maximize computer performance and maintain data integrity for files on the hard 
drive.  An entry will automatically be logged in the Windows™ system event log when this 
process is performed providing documentation of this step. 

c. Data Backup 

(1) Schedule of Data Backups 
Sample results generated by this analytical method are stored long-term on compact 
discs and on the CDC network shared drive.  The stored results must include at least the 
analysis date, quality-control (QC) results for the run, and the results of sample analysis 
by sample identifier (ID). 

Whenever making a backup (daily or weekly) include the directories and subdirectories: 

 C:\Users\Public\Documents\PerkinElmer Syngistix\ICPMS  (include all 
subdirectories) 

 C:\hplc (include subdirectories “data” C:\Users\Public\Documents\PerkinElmer 
Syngistix\ICPMS include the Application, Security, and System logs 

 Any other relevant files or folders. 

Daily.  Full data backups onto the laboratory’s (Isolated Secure Network Environment 
(ISLE).  

Weekly.  Full data backups onto one or more recordable compact discs (CD-R) or digital 
video discs (DVD).   

(2) Backup Procedures 
Before making a CD or DVD backup, saving the information from the Windows Event Viewer in 
C:\Event Log Backup will ensure archiving of all recent software system events including 
communications between ICP-DRC-MS and NexION® software, as well as times of hard drive 
defragmentation, and other Windows™ system events. 
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Figure 2-1:  Event Viewer 

If the computer has Windows 7 operating system, go to the Event Viewer and expand the 
“Windows Logs” folder.  Right click on Application.  Choose “Save All Events As…” Save the file 
in the folder “C:/Event Log Backup”. Name the file “Application NexION-I MM-DD-YY” where I is 
the instrument name (E, G, H, L, etc.) and “MM” is the month, “DD” is the day, and “YY” is the last 
two digits of the year. The following window will pop up.   

 

Select English as the language and click .   

Repeat this procedure for the Security and System folders. 

If the computer system is running on Windows XP, go to the Event Viewer and right click on 
Application.  Choose “Save Log File As” and save the file as “Event Log Backup 
(application).evt”. Repeat this procedure for the Security and System Logs. 
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(a) Secondary Hard Drive Backups

• Each instrument computer is configured to backup the relevant data and files
at a specified time each day. The backup files are stored on the laboratory’s
ISLE.

(b) Compact Disc Backups

• Use CD-R disks only (recordable compact disks) not CD-RW disks
(rewritable compact disks) so that the compact disk cannot be over-written
after creation. DVD discs are also acceptable when transferring large
amounts of data (or working with large databases).

• Back up the most recent project data on the hard drive onto a CD-R/DVD
disk. In Empower, select the “Configure the System” option.  On the left of
the screen select the Project folder. On the right select the current project
folder to backup Go to “File” → “Backup Project”. Browse to the CD or DVD
drive to select the CD to burn the backup files. Once done go to the window
and eject the disk.

• Backup the Empower database data on the hard drive monthly onto a DVD
disk. In Empower, select the “Configure the System” option.  Go to “File” →
“Backup Database”. Browse to DVD drive to select the DVD to burn the
backup files. Once done go to the window and eject the disk

• Keep the disk in a building other than the laboratory (in case of fire).

(c) Deleting Data from the Hard Drive

• If data needs to be deleted from the hard drive (i.e. for computer replacement
or upgrade, to free up hard drive space, etc.) backup all of the data on the
hard drive in duplicate using one or more disks.

• Verify that backup disks operate correctly before deleting any data from the
hard drive. To verify the operation of a disk, open any file on the disk by
using the appropriate computer software (ICP-DRC-MS software).

• After verifying that all backups are operational, delete the original data from
the hard drive.

• Keep one copy of the disk in a building other than the laboratory (in case of
fire). Keep the other copy in the ICP-MS laboratory.

d. Documentation of System Maintenance

Computer Maintenance:  

Record any maintenance of computer hardware or HPLC or ICP-DRC-MS software in the 
instrument logbook. This includes disk defragmentation, software upgrades, software patches, 
etc. 

Instrument Maintenance:  Document system maintenance in hard copies of data records (i.e., 
daily maintenance checklists, PerkinElmer® service records, and instrument log book) as well as 
in electronic records (e.g. hard copy of the daily performance check report). Whenever a service 
call is placed, store copies of any documents related to the service call in the instrument logbook 
and record the service in STARLIMS. 
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4. COLLECTING, STORING, AND HANDLING SAMPLES; CRITERIA 
FOR REJECTING SAMPLES 

a. Sample Type 

Sample type is human urine. No special instructions for fasting or special diets are required of 
patient or study subjects.  

b. Sample Collection, Handling, and Storage 

Optimal amount of sample is 1.0 mL; the minimum is 0.25 mL. Use sterile sample containers for 
sample acquisition. Acceptable containers for allotment of urine for this method include 5 mL 
polypropylene cryogenic vials (e.g., Nalgene, Item # 5000-0050), 2 mL polypropylene cryogenic 
vials (e.g. Nalgene, item # 5000-0020), 2 mL fluidX 2D coded cryo tubes (fluidX part 65-7532), or 
equivalent storage containers. Screen lots of sample collection cups, containers, and sample 
vials and tubes for total arsenic contamination prior to use.  

Sample handling conditions are outlined in the Division of Laboratory Sciences’ Policies and 
Procedures Manual. Every attempt is made to ensure that samples derived from outside direct 
CDC control are collected, stored, and transported in a manner that maintains the integrity of the 
samples as they were collected. This includes, but is not limited to, recognized proper sampling 
technique, storage in pre-screened containers, packaging and transport in suitably labeled 
containers that will maintain a temperature of approximately 4°C or lower throughout transport. To 
prevent possible inter-conversion of arsenic species, immediately store or transport urine 
samples at approximately -70°C or a lower temperature. Upon receipt, they must remain frozen at 
approximately -70°C or a lower temperature until time for analysis. Refreeze remaining portions 
at the same temperature. Samples thawed and refrozen several times may be compromised.   

c. Criteria for an Unacceptable Sample 

The criteria for deeming a sample unacceptable are low volume sample volumes (< 0.25 mL), 
suspected contamination due to improper collection procedures or collection devices, and/or 
contamination during sample preparation/analysis. Sample contact with dust or dirt may 
compromise test results. In all cases, request a second urine sample, if possible.   

 

5. CHEMICALS, STANDARDS, QUALITY CONTROL MATERIALS, 
AND WORKING CALIBRATORS 

a. Chemicals  

1. Deionized (DI) water, high purity (approximately 18 MΩ⋅cm resistivity), Aqua 
Solutions, or equivalent 

2. Ammonium carbonate, (CAS# 506-87-6), MW 96.09, GFS Chemicals, Item # 
839, or equivalent 

3. Tris(hydroxymethyl)aminomethane, (CAS# 77-86-1), MW 121.14, Bio-refined, 
GFS Chemicals, Item # 1948, or equivalent 
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4. Ammonium Sulfate, (CAS# 7783-20-2), MW 132.13, GFS Chemicals, Item # 
1906, or equivalent 

5. Ammonium Acetate, (CAS# 631-61-8), MW 77.08, GFS Chemicals, Item # 547, 
or equivalent 

6. Acetic Acid, Glacial (CAS# 64-19-7) M.W. 60.05, GFS Chemicals, Item # 624, 
or equivalent 

7. Ammonium Hydroxide, (CAS# 1336-21-6) M.W. 35.05, Fisher Scientific, Item # 
A470500, or equivalent 

8. Methanol (CAS# 67-56-1) M.W. 32.04, GFS Chemicals, Item # 2483, or 
equivalent 

9. 10% hydrogen in argon gas mixture, ≥ 99.999% purity, Airgas South, Inc., Item 
# X02AR90C350976, or equivalent 

10. Double-distilled nitric acid (CAS# 7697-37-2), GFS Chemicals, Item # 621, or 
equivalent 

11. Certified pH 7 and pH 10 buffer solutions, Fisher Scientific, Item # SB107-500 
and SB115-500, or equivalents 

12. Liquid argon, Airgas South, Inc., or equivalent 

13. Acetonitrile, HPLC grade (CAS# 75-05-8), GFS Chemicals, Item # 2482, or 
equivalent 

14. Accel TB™ Ready-to-use disinfectant, Fisher Scientific, Item # 19-130-5975, or 
equivalent broad spectrum disinfecting agent 

15. Base urine pooled from anonymous donors or purchased from a vendor 

b. Standards 

A mixture of the sources is used to make each set of calibration materials.  Alternate sources 
can be used, and the availability of the sources listed is subject to change without notice. 

1. Arsenobetaine (AB), CAS 64436-13-1, MW 178.06, Sigma-Aldrich (Item # 
11093-50MG) 

2. Arsenobetaine (AB), Santa Cruz Biotechnology (Item # sc-227279) 

3. Arsenobetaine (AB), Toronto Research Chemicals, Inc. (Item # A778500) 

4. Single Element Speciation Standard Arsenic (As), Arsenobetaine (AB), 10 
mg/L in H2O, 100mL, Elemental Scientific, Inc. (Item # S1-As-AsB-100) 

5. Arsenobetaine standard solution (AB), NIST (Item # SRM 3033) 

6. Arsenobetaine standard (AB), National Research Council Canada CRM (Item # 
ABET-1) 

7. Arsenobetaine (AB), Wako USA (Item # 321-34911) 

8. Arsenobetaine (AB), (CH3)3AsCH2COOH, CAS 64436-13-1, MW 178.06, 
Argus, Vernio, Italy (Item # AR60008)* 

9. Arsenocholine bromide (AC), Wako USA (Item # 328-34921 or Fisher Scientific 
Catalog # 50-994-368) 

10. Arsenocholine (AC), Toronto Research Chemicals, Inc. (Item # A778550) 

11. Arsenocholine bromide (AC), (CH3)3AsCH2CH2OH·Br, CAS 71802-31-8, MW 
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244.99, Argus, Vernio, Italy (Item # AR60010)* 

12. Trimethylarsine oxide (TMAO), CAS 4964-14-1, MW 136.02, Santa Cruz 
Biotechnology (Item # sc-475468) 

13. Trimethylarsine oxide (TMAO), Toronto Research Chemicals, Inc. (Item # 
T791070) 

14. Trimethylarsine oxide (TMAO), (CH3)3AsO, CAS 4964-14-1, MW 136.03, Argus 
Chemicals, Vernio, Italy (Item # AR60011)* 

15. Arsenic (III) oxide, Sigma-Aldrich (Item # 202673) 

16. Arsenic (III) oxide, Santa Cruz Biotechnology (Item # sc-210837) 

17. Arsenic (III) in 2%HCl, 1000 µg/mL, Spex CertiPrep (Item # SPEC-AS3) 

18. Arsenic (III) in 2%HCl, 1000 ppm, Inorganic Ventures (Item # CGAS(3)1-1) 

19. Arsenic (III) in 2%HCl, 1000 µg/mL, High Purity Standards (Item # 10003-6) 

20. Arsenic (III) in 2%HCl, 1000 µg/mL, ChemService (Item # X10003-6-100ML) 

21. Single Element Standard Arsenic ( As+3), 2% HCl, 10 mg/mL, Elemental 
Scientific Inc. (Item # S1-As+3-10x100) 

22. Arsenous Acid (AsIII) standard solution, NIST (Item # SRM 3037) 

23. Dimethylarsinic acid (DMA), CAS 75-60-5, MW 138.00 ChemService (Item # N-
11779-500MG) 

24. Dimethylarsinic acid solution (DMA) ChemService (Item # S-11779F4-1ML) 

25. Cacodylic Acid (DMA), Santa Cruz Biotechnology (Item # sc-239453) 

26. Cacodylic Acid (DMA), CAS 75-60-5, MW 138.00, Sigma-Aldrich (Item # 
20835-10G-F) 

27. Cacodylic Acid (DMA), CAS 75-60-5, MW 138.00, Alfa Aesar (Item # A12075) 

28. Single Element Speciation Standard Arsenic (As), Dimethylarsinic acid (DMA), 
10 mg/L in H2O, 100mL (DMA) Elemental Scientific, Inc. (Item # S1-DMA-100) 

29. Dimethylarsinic acid standard solution (DMA), NIST (Item # SRM 3031) 

30. Disodium methyl arsonate hexahydrate (MMA), CAS 144-21-8, MW 291.9, 
ChemService (Item # N-11817-500MG)  

31. Disodium methyl arsenate hexahydrate (MMA), MW 292.02 Santa Cruz 
Biotechnology (Item # sc-257380)  

32. Single Element Speciation Standard Arsenic, Monosodium methyl arsonate 
(MMA), 10 mg/L in H2O (MMA), Elemental Scientific, Inc. (Item # S1-MMA-
100) 

33. Monomethylarsonic acid standard solution (MMA), NIST (Item # SRM 3030) 

34. Monosodium acid methane arsonate sesquihydrate (MMA), CAS 2163-80-6, 
MW 189, ChemService (Item # N-12495-100MG) 

35. Monomethylarsonic acid disodium salt (MMA), CH3AsO3Na2, CAS 144-21-8, 
MW 183.93, Argus Chemicals, Vernio, Italy (Item # AR60009)* 

36. Arsenic (V) oxide hydrate, CAS 12044-50-7, MW 229.84, Sigma-Aldrich (Item # 
363456) 

37. Arsenic (V) oxide, CAS 1303-28-2, MW 229.79, Alfa Aesar (Item # 14668) 

38. Arsenic (V) in water, 1000 µg/mL, Spex CertiPrep (Item # SPEC-AS5)  
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39. Arsenic (V) in water, 1000 ppm, Inorganic Ventures, (Item # CGAS(5)1-1) 

40. Arsenic (V) in water, High Purity Standards (Item # 10003-7) 

41. Arsenic (V) in water, ChemService (Item # X10003-7-100ML) 

42. Single Element Standard Arsenic (As+5), 10 mg/L in H2O, Elemental Scientific 
Inc. (Item # M1-As-5-100) 

43. Arsenic Acid (AsV) standard solution, NIST (Item # SRM 3036) 

*No longer commercially available from Argus as of 11/05/2019. 

c. Quality Control Materials 

Quality control (QC) materials are prepared from pooled human urine collected from several 
anonymous donors. See the Preparation of Quality Control Material section of this method for 
details on preparation. The five urine QC pools made for arsenic speciation are designated as:  

QC level QC Designation ID 

Base pool Base Urine – 
Speciated Arsenic 

Low pool LU-YY102 

High pool HU-YY104 

Elevated pool A EU-YY110 

Elevated pool B EU-YY112 
 

where “YY” is the last two digits of the production year and the last three numbers in the name 
represent the assigned pool identification number for the arsenic speciation pools. QC material 
that is to be used for bench quality control purposes (i.e. LU, HU, and EU pools) will need to be 
“characterized” as described in the section 14 a. (Establish QC limits for each QC Pool). 

d. Working Calibrators 

Working calibrators are prepared from pooled human urine collected from several anonymous 
donors.  See the Preparation of Quality Control Material section of this method for details on 
preparation. The calibrators are diluted with the same diluent and in the same ratio as patient 
samples; therefore, frozen calibrators do not have to be prepared before usage. They are simply 
thawed and placed on the HPLC autosampler for analysis. 

Two types of calibrators are used for this method – the normal calibration range and the extended 
(or elevated) calibration range. The normal calibration curve is used routinely, and it covers 
concentrations from the LOD up to 150 µg/L. The extended calibration curve range is analyzed 
with samples with analyte concentrations between 150 µg/L up to 1000 µg/L. The extended 
calibration curve is only used after a sample has been analyzed with the normal calibration curve.  
If an extended calibration curve is needed, the sample is prepared again and reanalyzed with the 
extended calibration curve and appropriate QC. 

The calibration points in the normal calibration curve are designated as S0, S1, S2, S3, and S4. 
The calibration points in the normal calibration curve for the T series are designated as T0, T1, 
T2, T3, and T4.   
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The calibration points in the extended calibration curve are designated as S0, S4, S5, S6, and 
S7. The calibration points in the extended calibration curve for the T series are designated as T0, 
T4, T5, T6, and T7. 

6. INSTRUMENTATION, EQUIPMENT, SOFTWARE, AND SUPPLIES 

a. Instrumentation 

(1) ICP-DRC-MS System 
1. Inductively-coupled plasma mass spectrometer, specifically the NexION® 300D 

ICP-Mass Spectrometer with Universal Cell Technology (UCT™) and Dynamic 
Reaction Cell (DRC™) capability, PerkinElmer® LAS, or equivalent 

2. NexION® instrument control and data handling software, version 1.5 or greater, 
PerkinElmer® or Syngistix for ICP-MS software version 1.1 or greater 

3. Chiller 1 HP 230V/60HZ TP Quiet, PolyScience through PerkinElmer® (Item # 
N0772046) or equivalent 

4. Two external peristaltic 2-, 3-, or 4-channel peristaltic pumps, “Minipuls 3”, 
Gilson Inc., or equivalent 

5. NexION® 300 ICP-MS Detector, PerkinElmer® (Item # N8145000) or equivalent 

(2) Replacement and Periodic Maintenance of Key Components 
Part numbers listed below are PerkinElmer® part numbers from their 2015-2016 
Analytical Consumables and Supplies Catalog unless indicated. Equivalent high quality 
parts from other suppliers may be used as noted. 

1. Peristaltic pump tubing for sample and internal standard (0.76 mm i.d.), 
Analytical West (Item # PT-2130P), and for waste (3.18 mm i.d.), Analytical 
West (Item # N8122012) or equivalent   

2. Autosampler probe assembly (Item # B3000161) or equivalent  

3. Torch O-Ring kit, package of four (Item # N8120100) or equivalent  

4. Platinum sampler cone (Item # W1033614) or equivalent 

5. Platinum skimmer cone (Item # W1026907) or equivalent 

6. Aluminum hyper skimmer cone (Item # W1033995) or equivalent 

7. Sampler gasket (Item # W1040148) or equivalent 

8. Hyper skimmer o-ring (Item # 09902123) or equivalent 

9. Hyper skimmer screw (Item # WE027484) or equivalent 

10. Cone removal tool (Item # W1034694) or equivalent 

11. Torch alignment tool (Item # WE015554) or equivalent 

12. Quartz cyclonic spray chamber (Item # N8145013) or equivalent 

13. Quartz ball injector 2.0 mm i.d. (Item # WE023948) or equivalent 

14. Demountable quartz torch (Item # N8122006) or equivalent 

15. Load coil (Item # WE021816) or equivalent 

16. Fombulin® GV80 pump oil for the roughing pump (Item # N8145003) or 

Urine arsenic speciation 
NHANES 2019-2020

13 of 101



equivalent 

17. PE Sciex coolant (Item # WE016558A) or equivalent 

18. NexION® trap coaxial foreline (Item # W1036511) or equivalent 

19. NexION® exhaust filter kit SV40BI (Item # N8145005) or equivalent 

20. TQ+ Quartz nebulizer, Meinhard (Item # TQP-50-A0.5) or equivalent 

21. Nebulizer connection kit, Meinhard (Item # F2-50) or equivalent 

(3) HPLC System – Agilent Infinity 1260 Bio-Inert System - Equipment and 
Consumables 
Part numbers listed below are all Agilent part numbers unless otherwise specified. 

1. HPLC pump, specifically Agilent 1260 Infinity Bio-Inert Quaternary Pump (Item 
# G5611A) or equivalent 

2. HPLC autosampler, specifically Agilent 1260 Bio-Inert High Performance 
Autosampler (Item # G5667A) or equivalent 

3. Thermostat, specifically Thermostat for 1200 ALS/Fraction Collector (Item # 
G1330B) or equivalent 

4. Column compartment, specifically Agilent 1200 Series Thermostatted Column 
Compartment (Item # G1316B) or equivalent 

5. Control module, specifically Agilent Instant Pilot (Item # G4208-67001) or 
equivalent    

6. Stator face assembly for p/n 0101-0921 valve (Item # 0100-1851) or equivalent 

7. Frit, PTFE, 5/pk (Item # 01018-22707) or equivalent 

8. Peristaltic pump, silicone tubing (Item # 5042-8507) or equivalent 

9. PTFE solvent tubing 5 m, 1.5 mm ID, 3 mm od (Item # 5062-2483) or 
equivalent 

10. Frit adapter, 3 mm 4/pk (Item # 5062-8517) or equivalent 

11. Bio-inert 2 position/6 port injection valve for 1260 Bio-inert high performance 
autosampler (Item # 5067-4131) or equivalent 

12. Tubing Kit-degasser to pump (Item # G1322-67300) or equivalent 

13. Tray for well plate autosampler which holds 2 well plates (max 50mm high) and 
10 X 2 vials, Agilent G1367A, G1377A, G2258A well plate samplers (Item # 
G2258-60011) or equivalent 

14. 100 position tray for 2 mL vials with inserts (Item # G4226-60021) or equivalent 

15. Capillary starter kit, bio-inert (Item # G5611-68711) or equivalent 

16. Accessory kit, for 1260 Bio-inert Quaternary LC (Item # G5611-68755) or 
equivalent 

17. Tool for needle adjustment (Item # G5667-40500) or equivalent 

18. Bio-inert needle assembly for 1260 Bio-inert high performance autosampler 
(Item # G5667-87200) or equivalent 

19. Bio-inert stator for Bio-inert 2 position / 6 port injection valve (Item # 5068-
0060) or equivalent 

20. Rotor, 12-position/13-port bio valve, 200 bar (Item # 5068-0099) or equivalent 
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21. Bio-inert sample loop, 100 µL (Item # G5667-81006) or equivalent 

22. Rotor seal, 3 grooves, max 600 bar, for thermostatted column compartment, 
switching valve p/n 0101-0920 or G1158A switching valve (Item # 0101-1409) 
or equivalent 

23. Precolumn filter, IDEX Health and Science item # A-430 or equivalent 

(4) HPLC Supplies  
1. Anion-exchange HPLC column, specifically, PRP-X100™, 4.6 X 150 mm 

dimensions, 7 µm particle size in Polyether ether ketone (PEEK) hardware, 
Hamilton Company (Item # 79665) or equivalent  

2. Autosampler injector loop, 200 µL, ChromTech or IDEX Health & Science (Item 
# 9055-025) or equivalent 

3. Replacement precolumn blue microfilter 0.5 µm 10/pk, ChromTech or IDEX 
Health & Science (Item # A-735X) or equivalent 

4. Precolumn microfilter assembly PEEK, ChromTech or IDEX Health & Science 
(Item # M-560) or equivalent 

5. HPLC tubing, 0.007” I.D. X 1/16” O.D., polyethylethylketone (PEEK), 5 feet 
length, ChromTech or IDEX Health & Science (Item # 1536) or equivalent 

6. Vespel rotor seal for 6 port switching valves, ChromTech or IDEX Health & 
Science (Item # 7750-016) or equivalent 

7. Stator Rheodyne PEEK for 6-port switching valve, ChromTech or IDEX Health 
& Science (Item # 9750-021) or equivalent 

8. RheBuild Kits for 6-port switching valve, ChromTech or IDEX Health & Science 
(Item # 7501-999) or equivalent 

9. Dionex 2L HPLC reservoir bottles with cap, Dionex (Item # 44129) or 
equivalent 

10. Electrically-activated 6-port switching valve, IDEX Health & Science (Item # 
EV750-100-S2) or equivalent.  An additional switching valve may also be used 
as demonstrated in Section 8 Instrument Setup and Configuration.   

b. Laboratory Equipment  

1. Water purification system for providing ultrapure water with a resistivity of 
approximately 18 MΩ⋅cm, Aqua Solutions or equivalent  

2. Caliper Automated Staccato Sample Preparation System, Caliper Life Science 
Technologies or equivalent 

3. Eppendorf® Model 5417R refrigerated centrifuge fitted with FA45-24-11 fixed 
angle rotor or equivalent refrigerated centrifuge capable of ≥18,000 rcf for 
centrifugation of 1.5 mL capacity microcentrifuge tubes 

4. Eppendorf® Model 5427R refrigerated centrifuge fitted with FA-45-48-11 fixed 
angle rotor or equivalent refrigerated centrifuge capable of ≥16 000 g for 
centrifugation of 1.5 mL capacity microcentrifuge tubes 

5. High-precision analytical balance capable of accurately weighing milligram 
amounts of material to the tenth of a milligram or better, Sartorius™ Cubis™ 
MSA Precision balance, Item # MSA1203S100, Fisher Scientific or equivalent 

6. Analytical balance for routine weighing of material to the nearest hundredth of 
a gram and with a loading capacity of at least 200 g, Sartorius™ Cubis™ MSA 
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Analytical balance, Item # MSA324S100DI, Fisher Scientific or equivalent 

7. pH meter with one hundredths of a pH unit readout or better, fitted with glass 
electrode (pH probe), Accumet XL-150 or equivalent    

8. Hamilton Microlab 625 Diluter, Hamilton Company (Item # ML625-DIL) or 
equivalent 

9. Calibrated hand-held adjustable pipettes that cover the range of accurate liquid 
delivery from 50 µL to 5000 µL. Eppendorf™ Xplorer™, Fisher Scientific, or 
Sartorius Picus NxT, Sartorius Corporation, single channel electronic 
programmable pipettes, or equivalent 

10. Honeywell Xenon 1902 USB 2D barcode reader, Computech International 
(Item # 1902HHD-0USB-5F) or equivalent 

11. “Repeater Plus” Pipette, Fisher Scientific (Item # 2226020-1) or equivalent 
pipetting device(s) capable of accurately dispensing multiple microliter aliquots 
of liquid 

12. Vortex mixer, VWR (Item # 945303) or equivalent 

13. Gas regulator for 10% DRC™ gas, Matheson Tri-Gas Products or equivalent 

14. Gas regulator for argon gas, Matheson Tri-Gas Products or equivalent 

15. Stormat Sealer, PerkinElmer® (Item # CUSG01273) or equivalent 

c. Computer Software 

1. PdfFactory Pro 5 or later version, FinePrint Software, LLC, www.fineprint.com 
or equivalent. This product is used for creating electronic Portable Document 
Files (pdf) directly from Microsoft® Windows print dialog box 

2. Syngistix for ICP-MS software version, 1.1 or greater. 

3. Chromatography data handling software, specifically, Waters Empower 3 
Chromatography Data Software  

d. Supplies 

1. 2-200 µL pipette tips, 960 tips per case, Fisher Scientific (Item # 05-403-66) or 
equivalent 

2. 20-300 µL pipette tips, 960 tips per case, Fisher Scientific (Item # 05-403-67) 
or equivalent 

3. 50-1000 µL pipette tips, 960 tips per case, Fisher Scientific (Item # 05-403-68) 
or equivalent 

4. 5 mL pipette tips, 500 tips per case, Fisher Scientific (Item # 05-403-71) or 
equivalent 

5. 0.5-200 µL LowRet pipette tips, 960 tips per case, Sartorius Corporation (Item 
# LH-L790200) or equivalent 

6. 5-350 µL LowRet pipette tips, 960 tips per case, Sartorius Corporation (Item # 
LH-L790350) or equivalent 

7. 10-1000 µL LowRet pipette tips, 960 tips per case, Sartorius Corporation (Item 
# LH-L791000) or equivalent 

8. 5 mL pipette tips, 1000 tips per case, Sartorius Corporation (Item # 780308) or 

Urine arsenic speciation 
NHANES 2019-2020

16 of 101

http://www.fineprint.com/


equivalent 

9. Acid-washed 2 liter, 1 liter, 500 mL, 100 mL, and 50 mL polyethylene (PE) 
bottles.  To acid-wash containers, rinse with 10% (v/v) reagent-grade nitric 
acid, followed by rigorous rinsing with DI water to remove all traces of the acid.  
Repeat this process several times depending on prior use of the containers. 

10. 1.5 mL polypropylene (PP) microcentrifuge tubes, Fisher Scientific (Item # 05-
402-25) or equivalent 

11. 0.75mL virgin polypropylene HPLC vials, National Scientific (Item # C4011-15) 
or equivalent 

12. Red Snap-it seal T/S SLT septa, case of 1000, National Scientific (Item # 
C4011-55R) or equivalent 

13. Tube racks for 1.5 mL microcentrifuge tubes (approximately 6), Fisher 
Scientific (Item # 05-405-3) or equivalent 

14. Vial rack for HPLC autosampler vials, 50-position, Fisher Scientific (Item # 03-
375-9) or equivalent 

15. fluidX racks for Nalgene cryovials, Brooks Automation (Item # 170-01-110) 

16. fluidX racks for fluidX 2D cryotubes, Brooks Automation (Item # 65-9451) 

17. 2D coded jacket cryotubes external threaded with yellow caps 480 per case, 
Brooks Automation (Item # SP-2003) 

18. 2D coded jacket cryotubes external threaded with blue caps 480 per case, 
Brooks Automation (Item # SP-2004) 

19. 2D coded jacket cryotubes external threaded with orange caps 480 per case, 
Brooks Automation (Item # SP-1007) 

20. Corning 2mL V-bottom non-sterile 96 well plate, case of 100, Fisher Scientific 
(Item # 07-200-701) or equivalent 

21. Non-sterile deep well plates 1 ml capacity 50/case. Fisher Scientific (Item # 12-
566-120) or equivalent 

22. Easy Pierce Foil sealing tape, Thermo Scientific (Item # AB-3738) or equivalent 

23. Nested pipette tips 776 pipette tip – 200 µL SLV 30-96 trays, PerkinElmer® 
(Item # 105649) or equivalent 

24. Silicone STORMAT-96, 50/case, PerkinElmer® (Item # 6008096) or equivalent 

25. Eppendorf Repeater pipette tips Combitips Plus 5 mL, Fisher Scientific (Item # 
21-381-330) or equivalent 

26. Kay-Dry™ paper towels and Kim-Wipe™ tissues, Fisher Scientific (Item # 06-
666-11) or equivalent 

27. Teflon™-coated magnetic stirs bars, VWR (Item # 58948-974) or equivalent 

28. Nitrile, powder-free examination gloves, any vendor 

29. Biohazard autoclave bags, Fisher Scientific or equivalent 

30. 15 mL conical polypropylene centrifuge tube, VWR (Item # 82050-276) or 
equivalent 

31.  50 mL polypropylene centrifuge tubes, Fisher Scientific (Item # 14-432-22) or 
equivalent 
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7. STANDARD PROCEDURE 

a. Preparation of Stock Solutions 

1. 0.5 M Ammonium Acetate, pH 5. Dissolve 27.2 g of ammonium acetate and 
8.0 mL of glacial acetic acid into approximately 950 mL of DI water. Adjust pH 
to 5.0 by adding concentrated glacial acetic acid drop-wise. Bring volume to 
1000 mL with DI water, and mix thoroughly. This solution expires one year from 
the date made. Prepare ahead of time or as needed. 

2. 0.1 M Ammonium Acetate, pH 5. Dissolve 5.44 g of ammonium acetate and 
1.68 mL of concentrated glacial acetic acid into approximately 950 mL of DI 
water. Adjust pH to 5.0 using drop wise additions of either 10% ammonium 
hydroxide or glacial acetic acid.  Bring volume to 1000 mL with DI water, and 
mix thoroughly. This solution expires one year from the date made. Note: This 
solution is not prepared as a dilution of 0.5 ammonium acetate, pH 5. 

3. 0.5 M Ammonium Carbonate. Dissolve 48.05 g of ammonium carbonate into 
approximately 900 mL of DI water.  Bring volume to 1000 mL with DI water, 
and mix thoroughly. This solution needs to be filtered before use. This solution 
expires one year from the date made.  Prepare ahead of time or as needed.  

4. 0.5 M TRIS Buffer. Dissolve 60.57 g of tris(hydroxymethyl)aminomethane in 
approximately 900 mL of DI water. Bring volume to 1000 mL with DI water, and 
mix thoroughly. This solution expires one year from the date made. Prepare 
ahead of time or as needed. 

5. 0.5 M Ammonium Sulfate. Dissolve 66.07 g of ammonium sulfate in 
approximately 900 mL of DI water.  Bring volume to 1000 mL with DI water, 
and mix thoroughly. This solution expires one year from the date made. 
Prepare ahead of time or as needed. 

6. 5% Acetonitrile. To make autosampler rinse solution, add 50 mL of 
acetonitrile to 950 mL of DI water, and mix thoroughly. This solution expires 
one year from the date made. Prepare ahead of time or as needed.    

b. Preparation of Base Urine Pool 

Collect human urine from anonymous donors in clean, trace metals-free urine cups. 
Refrigerate urine donations at approximately 4°C as soon as possible for periods of two 
weeks or less. For longer periods, freeze the urine donations until needed. Analyze each 
donation for speciated arsenic. Exclude donated samples that contain detectable 
amounts of AC, TMAO, AsIII, and MMA. Exclude samples that have more than 2.5 µg/L 
total of AB and DMA combined. Reserve approximately two liters of urine that fit this 
criteria. Dispense approximately 40 mL of this pooled urine into 50 mL centrifuge tubes 
and store at approximately -70°C or a lower temperature. Label the tubes “Base Urine – 
Speciated Arsenic” or a similar designation.  

c. Preparation of Working Solutions 

1. 25% (v/v) Base Urine Pool in 0.075 M Ammonium Acetate, pH 5. May be 
prepared ahead of time before the day of analysis. To a clean 500 mL 
polypropylene (PP) bottle, add 75 mL of 0.5 M ammonium acetate pH 5, 125 
mL of “Base Urine – Speciated Arsenic”, and 300 mL of DI water for a total 
volume of 500 mL. Mix thoroughly. Store refrigerated at approximately 4°C.  
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Prepare as needed. The expiration date is one day from the date made.  

1. HPLC Buffer A Preparation (10mM Ammonium Carbonate/10 mM 
TRIS/0.5% MeOH pH 8.6). May be prepared ahead of time before the day of 
analysis. To a clean 2 L or greater capacity beaker containing a clean magnetic 
stir bar add 1.91L (2 liters with 90 mL removed) of DI water. Add the following:  

(a) 40.0 mL of 0.50 M ammonium carbonate  

(b) 40.0 mL of 0.50 M TRIS buffer  

(c) 10 mL of methanol. 

While the solution is being mixed on a magnetic stir plate, use a pH meter 
fitted with a glass electrode to monitor pH. Using a repeater pipette, slowly 
add either glacial acetic acid (to lower pH) or 10% ammonium hydroxide (to 
increase pH) drop-wise to bring the pH to 8.60 ± 0.05.  After complete 
mixing, transfer the beaker’s contents to HPLC “Bottle A” (or appropriately 
labeled container). Cap and mix thoroughly.  Label bottle “10 mM Amm. 
Carbonate / 10 mM TRIS / 0.5% MeOH / pH 8.6” (or other appropriate 
notation to indicate contents). Prepare as needed. The expiration date is two 
weeks from the date made.  

2. HPLC Buffer B Preparation (15mM Ammonium Sulfate/10mM Ammonium 
Carbonate/10 mM TRIS/0.5% MeOH pH 8.0). May be prepared ahead of time 
before the day of analysis. To a clean 2 L or greater capacity beaker containing 
a clean magnetic stir bar add 1.85 L (2 liters with 150 mL removed) of DI water.  
Add the following:  

(a) 40.0 mL of 0.50 M ammonium carbonate  

(b) 40.0 mL of 0.50 M TRIS buffer  

(c) 10 mL of methanol. 

(d) 60.0 mL of 0.50 M ammonium sulfate  

While the solution is being mixed on a magnetic stir plate, use a pH meter 
fitted with a glass electrode to monitor pH. Using a repeater pipette, slowly 
add either glacial acetic acid (to lower pH) or 10% ammonium hydroxide (to 
increase pH) drop-wise to bring the pH to 8.00 ± 0.1. After complete mixing, 
transfer the beaker’s contents to HPLC “Bottle B” (or appropriately labeled 
container). Cap and mix thoroughly. Label bottle “15 mM Amm. Sulfate / 10 
mM Amm. Carbonate / 10 mM TRIS / 0.5% MeOH / pH 8.0” (or other 
appropriate notation to indicate contents). Prepare as needed. The expiration 
date is two weeks from the date made. 

3. HPLC Buffer C (Autosampler Wash Solution) Preparation. 5% (v/v) 
acetonitrile (HPLC grade). Mix 50 mL of acetonitrile with 950 mL of DI water.  
Prepare as needed. The expiration date is one year from the date made. 

4. Internal Standard (2.5 µg/L) Preparation. May be prepared ahead of time 
before the day of analysis. Add approximately 950 mL DI water followed by 5.0 
mL of methanol to an empty 1 liter PP volumetric flask. Add 50 µL of 50 mg/L 
trimethylarsine oxide (TMAO Internal Standard Stock Solution) to the container 
and fill with DI water to the 1000 mL mark. Mix thoroughly. Prepare as needed. 
The expiration date is one year from the date prepared. 
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d. Preparation of Stock Standards (Concentrated) 

CAUTION! 
Arsenic compounds are toxic! Take extra care to avoid accidental ingestion or inhalation of these 
materials.  Utilize appropriate personal protective equipment.  At a minimum, wear a 
laboratory coat, safety glasses, and latex or nitrile gloves.  Clean up any spills that occur 
according to applicable hazardous material spill procedures.   

Note 1:  All preparations will be performed gravimetrically (wt/wt), unless 
otherwise noted.  All gravimetric measurements assume the density of water 
equal to 1g/cm3.   

 
Definitions: 
 

• Stock Standard: Initial solution of one of seven arsenic species prepared by 
dissolving solid or liquid standard material into aqueous or acidic solution.  

• Intermediate Standard: A 5,000 µg/L solution prepared from dilution of a Stock 
Standard.  

• Working Calibrator: A dilution of the Intermediate Standards prepared in urine 
and ammonium acetate buffer. A Working Calibrator is used in the urine arsenic 
species HPLC-ICP-DRC-MS analysis to build a calibration curve. 
 

Use a high precision analytical balance capable of accurately weighing material to 
the tenth of a milligram or better. It is important to use the balance in a vibration-free 
environment that is free of air drafts and away from direct sun light, to the fullest 
extent possible.   

1. Using a clean Teflon-coated spatula, or equivalent apparatus, prepare the 
arsenic Stock Standards described in TABLE 7-1 in 50.0 mL centrifuge tubes 
or other suitable storage vessels. Record the weights of the initial solid arsenic 
material for each species and all final weights of the corresponding arsenic 
solutions after dissolution.   

TABLE 7-1: PREPARATION OF STOCK STANDARDS 

Arsenic Species Range to 
Weigh (g) 

Solvent Used to Dissolve Final Weight (g) After 
Dissolution 

Arsenobetaine 0.02–0.03  DI Water 10.00  

Arsenocholine bromide (or 
other salt equivalent) 

0.20–0.25  DI Water 50.00 

Disodium methyl arsenate 0.20–0.25  DI Water 50.00  

Trimethylarsine oxide 0.10–0.125  DI Water 50.00 

Dimethylarsinic acid 0.10–0.125  DI Water 50.00  

Arsenic (V) oxide hydrate 0.10–0.125  DI Water 50.00 

Arsenic (III) oxide 0.10–0.125  Dissolve in 1.5 ml of 6N HCl with 
mild heating. Add DI water to 
complete volume 

50.00 

               

2. Tightly cap the storage vessels for future use. The expiration date is one year 
from the date weighed. 
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3. Calculate the concentration of each Stock Standard using the recorded weights 
for each species. The resulting units of concentration are milligrams per liter 
(mg/L). Record these values in a laboratory notebook.  

4. Calculate the “Arsenic (As) atomic equivalent” concentration of each arsenic 
species concentrated standard using Equation 1.   

Equation 1 

“As atom 
equivalent” 
conc. in mg/L 

= 
 concentration of concentrated

 stock standard in g/L    × # As atoms per
 species molecule   ×  74.92 atomic wt. As

 F.W. of As species  ×  10-3 g/mg
  

 

Insert into the equation the appropriate values for the formula weights (also 
referred to as molecular weights) and number of arsenic atoms per molecule 
for each species. A list of commonly used formula weights (F.W.) for each 
arsenic species is shown in TABLE 7-2. However, formula weights 
provided by the chemical manufacturers, if different, supersede the 
values presented in the table.  

 

 

 
Note:  All arsenic solutions from this point forward are referenced in terms of arsenic 
concentration. 

5. Record the “arsenic (As) atomic equivalent” concentration value on each 
arsenic stock standard storage vessel.  

e. Determination of Arsenic Purity for Stock Standards 

1. For each stock standard, make a 10,000-fold dilution as follows: 

a. Dilute 50.0 µL of stock standard to 100 mL in a clean volumetric flask with 
DI water. Mix well. 

b. In 15 mL test tubes, add 4 mL of DI water followed by 1 mL of the arsenic 
standard just diluted in (a) above. Mix well. 

c. Submit each diluted arsenic standard for analysis by Total Arsenic (DLS 
Method 3031 or equivalent). 

d. Also submit each diluted arsenic standard for testing of Chromatographic 

TABLE 7-2: FORMULA WEIGHTS OF ARSENIC SPECIES 

Arsenic Species Formula Weight Number of Arsenic 
Atoms per 
Molecule 

Formula 

Arsenobetaine 178.06 1 (CH3)3AsCH2COOH 
Arsenocholine bromide 244.99 1 (CH3)3AsCH2CH2OH·Br 
Disodium methyl arsenate 291.9 1 CH3AsO3· 6H2O 
Trimethylarsine oxide 136.03 1 (CH3)3AsO 
Dimethylarsinic acid 138.01 1 (CH3)2As(OH)2 
Arsenic (V) oxide hydrate 229.84 2 As2O5· xH2O 
Arsenic (III) oxide 197.84 2 As2O3 
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Purity by analysis with CLIA method “Urine arsenic species by HPLC-ICP-
DRC-MS”. See step 7.g. 

2. Use the total arsenic concentration results to calculate the arsenic purity for 
each arsenic species stock standard using Equation 2. 

Equation 2 

  

% arsenic purity   =  
reported total As concentration µg/L x 10−3 mg/µg x 10000 

"As atom equivalent" concentration in mg/L 
 x 100%  

 

f. Preparation of Intermediate Standards 

1. Prepare 5.00 mg/L diluted stock standard solutions by diluting a calculated 
volume of each standard into screened, 50 mL polypropylene screw-top 
centrifuge tubes using DI water. Use Equation 3 below to calculate the volume 
to pipet of each arsenic species standard. Add to the label of these 
Intermediate Standards: “As atom equivalent conc. = 5000 µg/L”. The 
expiration date of these solutions is one year from the date of preparation. 

  

Equation 3 

 

mL to pipet  = 
100 mL × 5 mg/L

 "As atom equivalent" concentration in mg/L × 100%
 % arsenic purity  

g. Assessment of Chromatographic Purity by HPLC-DRC-ICP-MS 

1. Using the CLIA “Urine arsenic species HPLC-ICP-DRC-MS” method, analyze 
each solution prepared in step 7.e.1. for the presence of arsenic species 
impurities which are defined as the presence of any other arsenic species that 
are included in Table 1-1 of this method. 

2. Tabulate all impurities for each solution. If significant (>5%) levels of impurities 
are found in any of the stocks except TMAO, consider purchasing additional 
standard solid material from an alternative source, if available, to remake the 
stock standard. If the total amount of impurities is small (<5%), it is permissible 
to calculate a correction factor which will be used to adjust the volumes in the 
next dilution step (i.e., preparation of Working Calibrators) so that the final 
concentration reaches the intended value.  

3. Correct the Stock Standard concentrations based on their purities. For 
example, if the Stock Standard solution of arsenobetaine (AB) was found to 
have 2% total impurities, the calculated value will be multiplied by 98% to 
obtain the pure value of this Stock Standard.   

4. For AB, AC, DMA, MMA, AsIII, or AsV solutions that are found to have 
impurities, be sure to add the concentrations of the impurities to the value of 
the species because once combined in the mixed calibrators the impurities will 
contribute to the final value for that species. Impurities in the TMAO solution 
will not be used in the calculation because TMAO will not be combined with the 
other species. 

Urine arsenic speciation 
NHANES 2019-2020

22 of 101



h. Preparation of Concentrated Stock Internal Standard  

Prepare ahead of time before the day of analysis.  The expiration date is one year from 
the date of preparation.    

1. Prepare concentrated Stock Internal Standard, 50 mg/L trimethylarsine oxide 
(TMAO). Dilute a calculated volume (µL) of trimethylarsine oxide (TMAO) stock 
standard in DI water to make a total volume of 20 mL. Calculate the volume 
(µL) of stock TMAO standard to add using Equation :  

Equation 4 

µL of stock TMAO 
standard to add =  

50 ppm × 20 mL × 1000 µL/mL
actual ppm of stock TMAO standard  

i. Preparation of Working Calibrators 

At any given time, it is necessary to have at least three sets of Working Calibrators in 
storage from two independent preparations of Stock Standards.  When possible, the 
original material should be from different lots, preferably from alternate vendors.  This is 
not always feasible due to the limited availability/sources of some of the arsenic 
compounds. Alternate usage of the different sets of working calibrators throughout the 
analytical runs. 

(1) Preparation of Intermediate “Mixed Species” Calibration Solutions 
To prepare the intermediate mixed species calibration solutions:  

1. Add 7.5 mL of 0.5 M ammonium acetate (pH 5) to a clean 50 mL volumetric 
flask labeled “Mixed As Species 250 µg/L” (or similar designation). Likewise, 
add 7.5 mL of ammonium acetate pH 5 to another dedicated 50 mL volumetric 
flask labeled “TMAO 250 µg/L” or something similar.  

2. To each flask, add 12.5 mL of base urine.   

3. To the flask labeled “Mixed As Species 250 µg/L”, add 2.50mL of each of the 
following 5000 µg/L Intermediate Standards: AC, AB, DMA, MMA, As(III) and 
As(V) - six solutions total - so that each analyte’s final concentration will be 250 
µg/L at a volume of 50.0 mL.  

4. To the flask labeled “TMAO 250 µg/L”, add 2.50 mL of the 5000 µg/L TMAO 
Intermediate Standard in order to obtain a 250 µg/L solution at a volume of 
50.0 mL. 

5. Bring both flasks to a final volume of 50.0 mL using DI water. Mix the contents 
of each flask thoroughly. Transfer each solution to an appropriately labeled 50 
mL centrifuge tube or equivalent container. This solution expires in 8 hours 
unless it is frozen. If the solution is frozen, the expiration date is 1 year from the 
date made. 

 

(2) Preparation of Working Calibrator Series 
*Note: The working calibrator series may be prepared by using either the diluter or 
handheld electronic pipettes. 

1. Label four 15 mL PP screw-top conical centrifuge tubes with caps as follows: 
“S0”, “S2”, “S3”, and “S4”. Label an additional four 15 mL PP centrifuge tubes 
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as follows: “T0”, “T2”, “T3”, and “T4”.Arrange these tubes in order and place in 
a test tube rack. Label two 50 mL PP screw-top conical centrifuge tubes with 
caps as follows: “S1” and “T1”. 

2. Inspect a Hamilton Microlab 625 diluter (or equivalent) to ensure that it has a 
clean 5 mL syringe on the left valve and a clean sample syringe (sizes vary 
according to volume dispensed see TABLE 7-5) on the right valve. If possible, 
it helps to have syringes dedicated to calibrator preparation.   

3. Program a method into the Hamilton Microlab 625 diluter using the values in 
TABLE 7-3 prior to the first time that the calibrators are made. The method can 
be saved and recalled each time calibrator preparation is needed. Please refer 
to the Hamilton, Microlab® 600 Advanced Manual Wizards and Custom Method 
Operation manual for assistance with programming. 

4. Thoroughly rinse the system out with DI water by priming. Place the fill line 
tubing into a container of DI water. Place an empty waste beaker in position to 
collect the effluent liquid from the tip of the dispensing probe. Press “Prime” to 
start the process and “Prime” to stop the process. Remove the fill line tubing 
from the water and use the prime function to clear residual water from the 
system. 

5. Place the fill line tubing into the buffered solution consisting of 25% base urine 
in 0.075 M ammonium acetate (pH 5). Place an empty waste beaker in position 
to collect the effluent liquid from the tip of the dispensing probe. Don the 
appropriate PPE (face shield). Prime the system. Allow the syringes to cycle 
the diluent through the syringes three to four times before pressing stop.  

6. Recall the method for calibrator preparation. 

7. To make the “S0” calibrators, the unit will simply draw diluent from the 500 mL 
PP bottle to be dispensed into the labeled 15 mL centrifuge tubes. Align the 
labeled 15 mL conical vial under the tip of the probe, and press the button 
(“trigger”) on the probe to dispense the solution into the centrifuge tube.  

8. Cap each centrifuge tube when the dispensing for that tube is complete. 

9. To make the calibrator levels “S1” through “S4”, the tip of Microlab 625 
sampling probe needs to be submerged in the “Mixed As Species 250 µg/L” 
intermediate solution prior to triggering the unit to start the dispensing steps.  
When the tip of the probe is submerged in the solution, press the trigger to 
draw up the solution. Once the appropriate amount of 250 µg/L mixed species 
is drawn into the probe, align the appropriate 15 mL centrifuge tube (or 50 mL 
centrifuge tube for S1) under the tip of the probe. When the trigger is pressed 
again, the indicated volume of diluent and sample will be dispensed to make a 
total volume of 10 mL of diluted calibrator in each tube (25 mL for S1 and T1).   

10. Between calibrators, rinse the tip of the sample/dispense tubing with DI water 
from a polypropylene wash bottle (or use disposable tips if the unit is so 
equipped). Flushes are programmed into the method between all of the 
calibrators except after S0. Direct the probe to the waste container to collect 
the diluent that is flushed out.   

11. After the S series calibrators have been made, repeat this process for the T 
series calibrators using “TMAO 250 µg/L”. 

12. Mix the contents of each tube thoroughly by vortexing and inverting repeatedly.  

13. Divide each calibrator into twenty (or less) 0.5 mL aliquots contained in 
correspondingly labeled clean HPLC autosampler vials. Cap each with a “snap-
cap” septum cap. Store at approximately -70°C or lower. The frozen calibrators 
expire one year from the date made. Store sets of S0 through S4 together for 
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the  calibration range.. Do the same for the T series calibrators. 

 TABLE 7-3: HAMILTON MICROLAB 625 SETTINGS FOR MAKING DILUTED SERIES 

CALIBRATORS 

Calibrator Level 

Microlab 625 Volume  
Setting, µL 

 
Target Arsenic 
Concentration 

(Nominal Conc. entered 
into HPLC software) 

Diluent  
Syringe 

Sample 
Syringe 

Sample 
Syringe Size, 

µL 

S0 / T0 5000 0 100  0 (0) 

 5000 0    

S0 DUP/ T0 DUP 5000 0 100  0 (0) 

 5000 0    

S1 / T1 5000 0   0.50 (2) 

 5000 0 100  

 5000 0   

 5000 0   

 4950 50   

S2 / T2 4950 50 100  2.50 (10) 

 4950 50   

S3 / T3 4750 250 500  12.5 (50) 

 4750 250   

S4 / T4 4250 750 1000  37.5 (150) 

 4250 750   

S4 DUP / T4 DUP 4250 750 1000  37.5 (150) 

 4250 750   

S5 / T5 2500 800 1000        62.5                (250) 
 2500 850   
 2500 850   

S6 / T6 1000 1000 1000      125.0                (500) 
 1000 1000   

 1000 1000   

 1000 1000   

 1000 1000   
Note:  S7/T7 do not have to be diluted with the Hamilton diluter.  See Section 7.k.(2).11. 

 

 

Urine arsenic speciation 
NHANES 2019-2020

25 of 101



j. Preparation of Quality Control Material 

Collect human urine from anonymous donors following the same collection procedure 
used for the preparation of the base urine pool. Assay each donation for speciated 
arsenic.  Total arsenic analysis is insufficient as a means to determine the baseline levels 
of arsenic in the individual cups. Assign each urine donation to the “low”, “high”, or 
“elevated” pools pool according to whether its falls below the spike levels for each of the 
individual analytes in each pool. Assign samples to the low and high pools first to ensure 
that you have an adequate volume of urine for each pool with values within the targeted 
spike levels.   

After pooling urine donations into their respective pools, clarify each pool by 
centrifugation in acid-washed 1 liter centrifuge bottles. A centrifugation time of 60 minutes 
at 5,250 x g in a preparative table-top centrifuge cooled to 4ºC is typically sufficient but 
additional centrifugation may be needed. Pour off the supernatant into a larger container 
and dispose of the residual solution/sediment in each bottle. Thoroughly mix the pooled 
urine, and analyze an aliquot using this analytical method (DLS 3000) to determine the 
levels of the endogenous urine species. To each pool, add a calculated volume of the 
chosen arsenic species standard solution to raise the concentration of that arsenic 
species to the desired value.  Arsenic speciation pools are prepared under nitrogen in an 
oxygen free environment. While maintaining constant stirring of each pool, aliquot 1.5 mL 
(or more) of urine into a sufficient number of pre-labeled 2 mL vials to provide QC 
material for 1000 or more runs. Store aliquotted QC material at approximately -70°C or 
lower. The expiration date of the pools is approximately 2.5 years from the date made. 

k. Processing of Urine Samples and QC Material 

Process a chosen number of urine samples and QC materials on the day of analysis. One 
run is defined as the analysis of a contiguous set of samples (typically 20 but this number 
can vary) bracketed by bench QC material at the beginning and end of the set. Each 
bench QC level needs to be analyzed at the beginning and end of a run in separate 
tubes/vials. Sharing of even a single QC tube or vial for more than one QC determination 
is disallowed. It is permissible to “piggyback” two runs in succession following a single 
calibration done during a single autosampler load (such as for an overnight analysis), as 
long as each run of samples is bracketed by its own uniquely co-prepared bench QC 
material. The number of samples per run can exceed 20 as long as the total analysis time 
for all vials under a single calibration does not exceed 24 hours. The 24 hour time limit 
includes the analysis of the calibrators as well as all QC, patient samples, and blanks.  
The sample preparation process can be completely automated using the Caliper sample 
preparation station. For detailed instructions on sample preparation using this method, 
refer to DLS-3503 (Operation of the Caliper Staccato Automated Sample Preparation 
Station for the Arsenic Speciation Analytical Method). For manual sample preparation, 
proceed with the steps below. 

1. Prior to initial use of the Hamilton Microlab 625, program a method in the unit 
that will be used for arsenic speciation sample preparation. The method can be 
saved and recalled each time calibrator preparation is needed.  Use a name 
such as “DLS 3000 Sample Prep” or some equivalent. Please refer to the 
Hamilton, Microlab® 600 Advanced Manual Wizards and Custom Method 
Operation manual for assistance with programming. 

2. In a step-wise, sequential, and user-controlled fashion the method will: 

(a) Uptake 600 µL of 0.1M ammonium acetate solution into the diluent 
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draw-line. 

(b) Uptake 20 µL of air into the sample draw-line. 

(c) Uptake 200 µL of sample (urine) into the sample draw-line. 

(d) Dispense 800 µL of sample/diluent mix (200 µL sample and 600 µL 
0.1M ammonium acetate solution).  

(e) Dispense 1000 µL of diluent (for flushing). 

(f) Repeat steps (a) – (e) until all samples, QC, and blanks are prepared. 

The method must be set up such that no step shall execute until the user has 
pressed the trigger button on the probe.   

Name and save this method into memory.    

For detailed instructions on programming, please consult the Microlab® 600 
Advanced Manual Wizards and Custom Method Operation manual.  

CAUTION! 
Work with open vials or tubes containing biological samples in a biological safety cabinet (BSC). 
Wear appropriate personal protective equipment (gloves, lab coat and safety glasses). 

3. Insert the Hamilton Microlab 625 sample fill line into the cap of a bottle of 0.1M 
ammonium acetate solution. To minimize evaporation, use a capped bottle with 
a small hole in the cap that is slightly larger than the outer diameter of the fill 
line tubing. After inserting the fill line through the hole of the cap, verify that the 
end of the fill line is completely submersed in the ammonium acetate solution.  
It is important that the end of the line remain submersed throughout sample 
preparation in order to prevent air bubbles and the possibility that the full 
volume of diluent will not be dispensed.  

4. Put on the appropriate PPE (face shield) and use the prime function to flush 
the 0.1M ammonium acetate solution through the dispenser. Three to four 
priming cycles is sufficient. Make sure that an empty waste container is placed 
at the end of the sample probe prior to starting the priming process. Do not 
leave the unit unattended while priming. 

5. Identify, gather, and thaw the vials of urine samples for the each analytical 
batch (“run”).  

6. Likewise, for each batch run, thaw one tube each of low and high bench QC 
samples “LU-yyxxx” and “HU-yyxxx” (for explanation of nomenclature see the 
Quality Control Material section).   

7. Label the required number of 1.5 mL microcentrifuge tubes that will be used for 
patient samples, blanks, and bench QC that will be analyzed. Label a pair of 
microcentrifuge tubes for each bench QC level (LU and HU ) since each bench 
QC will be injected at the beginning and end of each batch run and need to be 
contained in separate tubes. Likewise label an equal number of HPLC 
autosampler vials and set these aside for later use. If two runs will be done 
under a single calibration, label four microcentrifuge tubes and HPLC vials for 
each QC level. Use preprinted barcode labels to improve efficiency and reduce 
the chance of labeling errors.  

8. Recall the sample preparation method created in steps 1 and 2. Using this 
method, follow its steps to deposit the diluted sample into its respective, pre-
labeled 1.5 mL microcentrifuge tube. Cap the microcentrifuge tube.  Note that 
calibrators, which have been pre-made, do not undergo this type of sample 
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preparation.   

9. Between samples, wipe the dispensing tip with a clean KimWipe or rinse with 
DI water to avoid sample to sample contamination.       

10. When this process is complete, vortex each capped microcentrifuge tube for 3-
5 seconds. Next, centrifuge tubes for 5 minutes at a minimum of approximately 
16,049 x g to 20,800 x g in a refrigerated centrifuge pre-cooled to 
approximately 4°C. The g force will depend on the rotor used and the level the 
vials are at on the rotor (for the FA-45-48-11 rotor with two levels). 

11. Following centrifugation, transfer approximately 0.6 mL of the supernatant to 
the appropriately pre-labeled HPLC autosampler vials. Be careful not to disturb 
any pellet that might be present at the bottom of the microcentrifuge tube 
during transfer. Cap all autosampler vials with the proper fitting “snap-cap” 
septum caps.  

12. Thaw one “set” of calibrators, including S0 – S4 and T0 – T4, if needed, at 
room temperature. Vortex each thawed calibrator for 3-5 seconds. 

13. To autosampler vials labeled “Bk” (which stands for “Blank”), 0.6 mL of the 
samples prepared by adding 200 µL of DI water and 600 µL of 0.1M 
ammonium acetate solution.   

14. For each run, one extra sample of 200 µL LU-xxxx and 600 µL 0.1M 
ammonium acetate solution is needed. This sample is used for instrument 
equilibration and conditioning only, so a LU-xxxx vial from a previous day’s run 
containing leftover sample will suffice. If there are no leftover samples, one 
may be made using this sample preparation procedure.   

15. After sample preparation is complete, use a broad spectrum disinfectant, or 
other appropriate cleaner, to clean up the laboratory prep areas used as well 
as any spills that may have occurred. 

8. INSTRUMENT SETUP AND CONFIGURATION 

a. HPLC Hardware Setup 

The initial installation of the HPLC system will be performed by a representative from the vendor.  
If the instrument has been moved, laboratory personnel can assemble and configure the system 
according to the Agilent supplied user manuals and the SOP for this analytical method. The 
following considerations are necessary in planning a new location: 

1. Two 6-outlet A/C power strips rated for 15-amp duty will be required to plug-in 
all HPLC equipment and its associated components. 

2. The HPLC equipment needs to be placed adjacent to the right side of the ICP-
DRC-MS instrument.  Allow for approximately 4 to 7 feet of bench space for the 
HPLC equipment and data processing computer.    

3. HPLC components need to be arranged in the following order:  

(a) Six-port switching valve “#1” (EV750-100) 

(b) Six-port switching valve “#2” (EV750-100-S2).  This switching valve 
must have a serial port for connection to an external desktop computer. 

(c) Column oven.  The column oven can be placed under the pump and 
autosampler. 
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(d) Pump with autosampler. Set the pump on top of the autosampler.

4. The Infinity system comes with the appropriate loop installed.

5. Use “yellow” PEEK tubing (0.007” I.D. X 1/16” O.D.) throughout the fluid path.
Keep tubing lengths short but long enough to allow the connected components
to be moved if necessary.

6. Attach via a plastic tie clamp (or equivalent) one end of a given length of ¼”
diameter Tygon™ tubing to the end of the bench holding the HPLC equipment.
Position the other end of this Tygon™ tubing to empty into a large waste
container. Position this tubing close enough to the 6-port switching valves so
that HPLC drain tubing from ports 5 and 6 (dedicated for effluent waste) on
switching valves #1 and #2, respectively, will easily fit into the Tygon tubing.

b. Software Installation

Syngistix for ICP-MS software version 1.1 or greater must be installed. If it is not, contact a 
PerkinElmer® service representative to get the latest version of the software installed. 

Empower Quickstart software version 3 must be installed. It is advised that a PerkinElmer® 
representative install and initially configure Empower software to work with instrumentation. This 
includes the setup of the method file for DLS method 3000. 

PdfFactory Pro 5 or a greater version (FinePrint Software, LLC) is software used for creating 
electronic Portable Document Format (PDF). Documents are “printed” from the Microsoft® 
Windows print dialog box, but instead of printing on paper, the document appears on the screen 
in preview form. The document can then be either printed in hardcopy or saved to a hard drive or 
disk as a PDF file. Because of the “trial and error” nature of chromatographic integration, frequent 
reprocessing and reprinting may be required.  In these instances, generating PDF documents 
with the option to print a hardcopy becomes an indispensable tool.  

c. Peristaltic Pump Setup

An external peristaltic pump offers a number of advantages over the peristaltic pump built into the 
ICP-DRC-MS. It can be started, stopped and its speed set independent of the ICP-DRC-MS 
control software. This “feature” is important because the HPLC pump will continue to pump 
mobile phase regardless of whether the spray chamber is being drained or not. Likewise, the 
built-in peristaltic pump is under NexION® software control only and cannot be operated in 
manual mode. While it is feasible to configure the NexION® software to force the built-in peristaltic 
pump to keep emptying the spray chamber after completing an analysis, it is nonetheless easy to 
make a mistake during the NexION® program setup. The built-in pump’s timing and speed is set 
in the NexION®’s sample file and not the method file. The sample file is created each time before 
a batch run posing the risk that the built-in peristaltic pump’s timing and speed could be set up 
incorrectly or forgotten by the analyst. If this happens, the software will stop the built-in peristaltic 
pump well before the HPLC pump stops, causing the spray chamber to flood and the plasma to 
be extinguished. Since the HPLC pump can only be stopped manually, it is quite possible for the 
HPLC to pump mobile phase for an extended time before it auto-stops causing extensive flooding 
of the torch box and the ICP-DRC-MS, which can result in damage to the instrument electronics.  
Set up one multi-channel peristaltic pump (Gilson “Minipuls 3” or equivalent) near the ICP- MS 
spray chamber for the purpose of draining liquid from the spray chamber and a separate multi-
channel pump next to that one for the purpose of pumping the internal standard. 

1. Do not connect the peristaltic pumps to the control computer; connect the
pump to A/C power only. Run the pump in manual mode only.
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2. Designate one peristaltic pump for nebulizer waste tubing. Press the + or – 
(dependent upon direction) to set to control to approximately 6.25 or greater. 

3. Designate the other peristaltic pump for post-column internal standard tubing.  
Press the + or – (dependent upon direction) to set to control to approximately 
5.75 or greater. 

d. Electrical Connections 

For the Agilent HPLC system, the initial connection of the switching valves to the HPLC system, 
and configuration to work with Empower software has to be completed by an authorized 
PerkinElmer service engineer.   

e. Six-Port Switching Valves 

Each 6-port switching valve’s set of DIP switches need to be configured upon initial installation.  
The valves will not respond to the ~1 second contact closure from the HPLC autosampler if they 
are not put into “pulse mode”. This only needs to be done once for each new unit. (Settings of the 
front panel buttons must be checked before the start of each chromatographic run). For each 6-
port switching valve: 

1. Turn the switching valve unit upside down and remove the 4 screws. Remove 
the metal cover and look for DIP switch “SW3” on the printed circuit board. Use 
a small flat-head screwdriver to adjust the position of each switch so that it 
matches the following illustration. This illustration applies to both EV750-100 
and EV750-100-S2.   

 

Rheodyne® EV750-100 DIP Switch “SW3” 

DIP switch # 1 2 3 4 5 6 7 8 
Position up up down down down up up down 

2. A PerkinElmer service engineer will configure a remote cable to connect the 
Agilent HPLC to the left and right switching valves. 

 

Urine arsenic speciation 
NHANES 2019-2020

30 of 101



Position both 6-port switching valves close to and on the left side of the HPLC 
Column Oven, adhering to the order listed in Section 8.a.3. Using supplied 
HPLC pressure fittings, make HPLC tubing connections to the appropriate 
ports as described in TABLE 8-1-A and TABLE 8-1-B. 

 

TABLE 8-1-A: TUBING CONNECTIONS ON EV750-100 

Valve  
Port 

Flow Direction Tubing  
Description From To 

#1 Valve Port #1 Sample Loop PEEK (200 µL loop) 
#2 Valve Port #2 on 

EV750-100-S2 
Valve Port #2 HPLC tubing, 0.007” i.d., 

1/16” O.D., “yellow” PEEK 
#3 Valve Port #3 Nebulizer PEEK Sample Uptake 

Fitting 
#4 Sample Loop Valve Port #4 PEEK (200 µL loop) 
#5 Valve Port #5 Waste PP or PFA Tubing,  

0.03” i.d., 1/16” o.d.,  
#6 Internal Standard 

(via external 
peristaltic pump) 

Valve Port #6 PP or PFA Tubing,  
0.03” i.d., 1/16” o.d.,  

 
 
 

TABLE 8-1-B: TUBING CONNECTIONS ON EV750-100-S2 

Valve  
Port 

Flow Direction Tubing  
Description From To 

#1 HPLC column Valve Port #1 HPLC tubing, 0.007” i.d., 
1/16” O.D., “yellow” PEEK 

#2 Valve Port #2 Valve Port #2 on 
EV750-100 

HPLC tubing, 0.007” i.d., 
1/16” O.D., “yellow” PEEK 

#3 Line-In for 
Various Solutions 

(via ICP-MS 
peristaltic pump) 

Valve Port #3 PP or PFA Tubing,  
0.03” i.d., 1/16” o.d., 

#4 Valve Port #4 bridge HPLC tubing, 0.007” i.d., 
1/16” O.D., “yellow” PEEK 

#5 bridge Valve Port #5 HPLC tubing, 0.007” i.d., 
1/16” O.D., “yellow” PEEK 

#6 Valve Port #6 Tygon™ Waste 
Line 

PP or PFA Tubing,  
0.03” i.d., 1/16” o.d., 
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3. The switching valves are now ready for operation.   
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9. INSTRUMENT SETUP AND CONFIGURATION 

a. Method Set Up in Empower Quickstart 

The setup of the method in Empower Quickstart should be completed by a PerkinElmer 
engineer.  

1. In Empower Quickstart, select ”View Method” from the left hand side of the window.  Click 
File → Open → Select method “As_HPLC1_DRC”.  On the “Instrument Method” tab 
verify the information in the following steps. 

2. Verify that the information in the “NexION 300D” window matches what is listed in TABLE 
9-1 below. 
 

TABLE 9-1: NEXION®  EMPOWER PARAMETERS 

Settings  

Run Time (min):  9.5 
Mass Calibration: C:\Users\Public\Documents\PerkinElmerSyngistix\ICPMS\MassCal\default.tun  
Conditions: C:\Users\Public\Documents\PerkinElmerSyngistix\ICPMS\Conditions\As_HPLC.dac 
Mode: DRC 
Cell Gas A Flow 
(mL/min): 0.6 

Cell Gas B Flow 
(mL/min): 0 

Advanced  
QID: On 
Detector: Pulse 
Sampling (pts/s): 3.9 
Readings: 2244 
Plasma Off at End of 
Method: Unchecked 

Diverter Valve  
Delay after Start (min): 0 
Switch at (min): 0.0 
Post- Injection Events  
Time (min): 0.0 
Valve Position: LC to ICP-MS 

Add Analytes  

Name Mass Dwell 
Time (ms) RPa RPq MSIS Corr Interference 

Corrections 
As75 74.9216 250.0 0.0 0.50 … …  

  
 

 
 
 
 
 

Urine arsenic speciation 
NHANES 2019-2020

33 of 101



3. Verify that the information in the “Quat. Pump.” Tab of the “AgilentLC” window, matches 
the information provided in TABLE 9-2. 
 

TABLE 9-2: QUAT. PUMP (AGILENT 1260 INFINITY) PARAMETERS 

Flow  

1.000:  mL/min 
Solvents   

A:  
B: Check box; 0.0% 
C: 0.6 
D: 0 

Pressure Limits  
Min: 0.00 bar 
Max: 600.00 bar 

Stoptime 3.9 
Deselect radio button: As Injector/No Limit 
Select radio button: 9.50 min 

Posttime  
Select radio button: Off 
Deselect radio button: 0.0 (greyed out) 

Timetable  

Time (min) A(%) B(%) C(%) D(%) Flow 
(mL/min) Max Pressure Limit (bar) 

0.00 100.00 0.0 0.0 0.0 1.0.00 600.00 
5.00 0.0 100.0 0.0 0.0 --- --- 
9.50 0.0 100.0 0.0 0.0 --- --- 
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4. Verify that the information in the “Sampler” tab on the “AgilentLC” window, matches the 
information provided in TABLE 9-3. 

  
TABLE 9-3: HIP SAMPLER (AGILENT 1260 INFINITY) PARAMETERS 

Injection  

Injection volume: 20.00 µl 
Needle Wash   

Checked Enable Needle Wash 
Mode: Flush Port 
Time: 1.0 s 
Location:  
Repeat:  

Auxiliary  
Draw Speed: 200.0 µL/min 
Eject Speed: 200.0 µL/min 
Draw position: 0.0 mm 
Equilibration time: 2.0 sec 
Sample flush out factor: 5.0 times injection volume 
Unchecked: Vial/Well bottom sensing 

Stoptime 3.9 
Select radio button: As Pump/No Limit 
Deselect radio button: 1.00 (greyed out) 

Posttime  
Select radio button: Off 
Deselect radio button: 1.00 (greyed out) 

High Throughput  
Unchecked Automatic delay volume reduction 
Unchecked Enable overlapped injection 
Greyed out When Sample is Flushed Out 
Greyed out After Period of Time 
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5. Verify that the information in the Column Comp.” tab of the “AgilentLC” window, matches
the information in TABLE 9-4.

TABLE 9-4: COLUMN COMP. (AGILENT 1260 INFINITY) PARAMETERS 

Temperature (for 
both left and right) 

Select radio button for 
specific temp: 35.0 °C 

Valve 
Port 1 -> 2 

Enable Analysis (for 
both right and left) 

Checked When front door open 
Radio button for: When temperature is within +/- 0.8 °C 

Stoptime 3.9 
Select radio button: As Pump/Injector 
Deselect radio button: 1.00 (greyed out) 

Posttime 
        Select radio button: Off 

Deselect radio button: 1.00 (greyed out) 

6. Select the “PCI Valve” tab, verify that that the table reads Time (min): 0.5 and Pulse
(Min): 0.5.

7. Verify that the information in the “AglientLC” icon under the “Pretreatment Method” tab
matches the information provided in TABLE 9-5.

TABLE 9-5: PRETREATMENT METHOD (AGILENT 1260 INFINITY) PARAMETERS 

Function Parameter 

Wait: Wait 6.5 min. 
Draw: Draw default volume from sample with default speed using default offset 
Inject: Inject 

8. Leave all other tabs in the Instrument Method as is. The method “As_HPLC1_DRC” is
ready for use.

9. Open the method “As_HPLC1_DRC_WASH” and verify that the run time for the “NexION
300D” is set to 20 min.  On the “AgilentLC” tab for the “Quat. Pump” verify that Solvents
D: is checked and set to 100.0% and the stoptime is set for 20.00 min. The “Column
Comp.” should have not controlled selected for temperature. Once those have been
verified “As_HPLC1_DRC_WASH” is ready for use.

10. Open the method “SHUTDOWN_CDC” in the “Instrument” tab verify the following: for the
“NexION 300D” that the box is checked for “Plasma Off at End of Method”. On the
“AgilentLC” tab, for the “Quat. Pump” the flow is 0.000 mL/min and the stop time is 1.00
min. Once those have been verified “SHUTDOWN_CDC” is ready for use.
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b. ICP-DRC-MS Instrument Setup 

To improve workflow, complete the programming steps described in this section before the 
instrument is used for its first analytical run.  

(1) Programming the DRC™ Gas Flow Delay Parameter 
A special NexION® DRC™ setting, called “Flow Delay”, needs to be changed from its default 
setting to avoid the problem of the NexION® software forcing a time delay of several seconds 
before collecting data at the start of a chromatographic run in DRC™ mode. This change only 
needs to be done once per software installation or upgrade, or if the setting was deliberately 
changed by a field service engineer. It is a good idea to inform the service engineer who intends 
to perform work on the instrument of the importance of returning the “Flow Delay” to the non-
default value of 1. This must be done in Service mode. 

1. From within the NexION® software in the “Instrument Control Session” window, 
choose menu item Options > Configuration.   

2. Click on the “set” button under the “Cell Gas Delays” section. If the “Flow 
Delay” (Gas changes while in DRC™ Mode) setting is a value other than “60”, 
change the value in the field named “Flow Change” to “60”. Click “Apply” then 
click “Close.”    

(2) Programming the NexION® “.mth” file 
1. If it is not already open, launch the NexION® program and in the “Instrument 

Control Session” window, choose menu item File > Review Files. Click the 
“Load” button for “Method”, the first item on the list.  Navigate to the folder 
“C:\NexIONdata\Method” or alternatively “C:\NexIONdata\Method\As Spec 
Methods” and click on “As_HPLC-1_drc.mth” file* then click the “Open” button.   

2. Proceed to step three unless, the “As_HPLC-1_drc.mth” file cannot be found, 
or it has been changed or corrupted in a manner that makes its use 
questionable. If this is the case, cancel the open file dialog box and close the 
Review Files window by clicking “Done”. Perform the following steps: 

(a)  Make the active method file the active window. Do this by clicking on the 
tool bar icon that looks like a notepad with a “Cu” on it. Click File > New 
on the menu bar and then choose “Data Only” in the New Method 
window that appears. Click “OK “then maximize the window.  Enter the 
information in TABLE 9-6 into this window :  

*Actual file names may differ from those presented throughout this document.  
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TABLE 9-6: NEXION® TIMING PARAMETERS 

Parameter Setting 

Sweeps/Reading: 1 
Readings/Replicate: 1403 
Number of Replicates: 1 
Mass Cal File: C:\NexIONdata\masscal\default.tun 
Mass Cal File (Syngistix): C:\Users\Public\Documents\PerkinElmerSyngistix\ICPMS\MassCal\default.tun  
Optimization File: C:\NexIONdata\conditions\As_HPLC.dac 
Optimization File 
(Syngistix): C:\Users\Public\Documents\PerkinElmerSyngistix\ICPMS\Conditions\As_HPLC.dac 

  
 

(b)  On the first line of the worksheet-like table, click in the cell of row 1 of the 
“Analyte (*)” column.  Type “As” then the press “Enter”. The row will 
suddenly be filled-in with arsenic’s “Begin Mass (amu)” of 74.92 (or 
something close) and several default parameters. Tab from cell to cell to 
fill in the information shown in TABLE 9-7. 

TABLE 9-7: NEXION® ANALYTE PARAMETERS 

Parameter Setting 

Analyte: As 

Begin Mass (amu): 74.9216 (or something close will be automatically entered 
by software) 

End Mass: <leave empty> 
Scan Mode: Peak Hopping 
MCA Channels: 1 
Dwell Time: 488 
Integration Time: 
Corrections: 
Mode: 
Cell Gas A: 
Cell Gas B: 
RPa: 
RPq: 

(automatically determined by software) 
<leave empty> 
<right click to choose> DRC 
<instrument specific> 0.55 
<leave empty> 
<leave empty> 
<instrument specific> 0.50 

  
  

(c) Click on the “Processing” tab and enter the information from TABLE 9-8. 
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TABLE 9-8: NEXION® PROCESSING PARAMETERS 

Parameter Setting 

Detector: Pulse 
Measurement Unit: Cps 
Process Spectral Peak: Average 
Process Signal Profile: Average 
Baseline Readings: 0 
Apply Smoothing: Checked 
Factor: 5 
Auto Lens: On 
Isotope Ratio Mode: Off 
  

(d) Skip the “Equation” tab. Click on the “Sampling” tab and enter the 
information from TABLE 9-9.  

TABLE 9-9: NEXION® SAMPLING PARAMETERS 

Parameter Setting 

Peristaltic Pump Under 
Computer Control: Checked 

Peristaltic Pump:  
         Sample Flush: Time: 0 Speed: 0.0 
          Read Delay: Time: 0 Speed: 0.0 
          Analysis: Time: 0 Speed: 0.0 
          Wash: Time: 0 Speed: 0.0 
Sampling: External 
  

(e) Click on the “Report” tab and enter the information TABLE 9-10.  

TABLE 9-10: NEXION® REPORT PARAMETERS 

Parameter Setting 

Report View | Send to 
Printer: Unchecked 

Report Options Template: <leave empty> * 
Automatically Generate 
NetCDF File: C:\NexIONdata\reportoutput\ 

Automatically Generate 
NetCDF File (Syngistix): C:\Users\Public\Documents\PerkinElmerSyngistix\ICPMS\ReportOutput\  

Report to File | Send to File: Unchecked 
Report Options Template: <leave empty> * 
Report File Name: <leave empty> * 
Report Format: Use separator 
File Write Option Append 

* Content of these fields is not important since Send To Printer/File is unchecked.  
 
 

(f)  Choose menu item File > Save As and navigate to 
“C:\NexIONdata\Methods\” folder.  Enter “As_HPLC-1_drc.mth” as the 
name of the method file and click the “Save” button.  
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3. The NexION® method “As_HPLC-1_drc.mth” is now loaded into memory.  

(3) Programming the NexION® “.dac” file 
1. If it is not already open, launch the NexION® program and in the “Instrument 

Control Session” window, choose menu item File > Review Files. Click the 
“Load” button for “Conditions”, the sixth item on the list.  Navigate to the folder 
“C:\NexIONdata\Conditions” and click on the “as_hplc.dac” file then “Open”.  

2. If the “as_hplc.dac” file cannot be found, or it has been changed or corrupted in 
a manner that makes its use questionable, cancel the open file dialog box and 
close the Review Files window by clicking the “Done” button. Do the following 
steps; otherwise, proceed to step 4: 

(a) Make the active method file the active window (do this by clicking on the 
tool bar icon that looks like two gears). Then click File > Open on the 
menu bar, navigate to the folder “C:\NexIONdata\conditions\”. Click on 
the most current “default.dac” file then click the OK button. Complete 
the “Current Value” column with the information in TABLE 9-11.  Note: 
Values in TABLE 9-8 are suggested starting values.  Instruments vary in 
their optimal parameter values, and analysts will use their discretion and 
expertise in establishing final parameters.     

TABLE 9-11: NEXION® OPTIMIZATION PARAMETERS 

Parameter Setting Parameter Setting 

Nebulizer Gas Flow (NEB): 0.9*   
Auxiliary Gas Flow: 1.2 DRC™ Mode NEB 0.9* 
Plasma Gas Flow 18 DRC™ Mode QRO -7.5* 

ICP RF Power: 1600 DRC™ Mode Cell 
Entrance Voltage -4* 

Analog Stage Voltage: - 1600* DRC™ Mode Cell Exit 
Voltage -4* 

Pulse Stage Voltage: 
Discriminator Threshold: 
Deflector Voltage: 

1000* 
12 

-10* 
DRC™ Mode CRO -2* 

Quadrupole Rod Offset 
[QRO] 0* DRC™ Mode AFT 250* 

Cell Entrance Voltage - 3* DRC™ Mode RPa 0 
Cell Exit Voltage -3* DRC™ Mode RPq 0.50* 
Cell Rod Offset {CRO} -12* DRC™ Mode Cell Gas A 0.55* 
  DRC™ Mode Cell Gas B 0 

*Suggested starting values only. Optimum parameters will depend on outcome of the optimization 
procedure. 
 

(b) Choose menu item File > Save As in the NexION® “Instrument Control 
Session” window menu bar and navigate to 
“C:\NexIONdata\Conditions\” folder. Enter “as_hplc.dac” as the name of 
the optimization file and click the “Save” button.  

The NexION® method “as_hplc.dac” is now loaded into memory.  
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(4) Creating the Empower Sample Set Method Set 
NOTE: This will take you through the initial process of setting up a sample set method. This only 

needs to be done once upon initial set up. It will be saved on each instrument with the title XXX.  
The daily sample set method can be made by opening the generic sample set method and 
editing as needed using steps C. xiv. 5. 

1. Click “File” → “New Sample Set” → “Using Wizard…” 

2. Select the radio button for “Create a sample set method using this wizard” → 
“Next”. 

3. Ensure that the radio button for “LC or PDA/MS” is selected. 

4. Click on the “Define Plate” button. 

(a) Click in the row beneath the heading “Plate Type Name” and select the 
desired plate format depending on the type of sample geometry to be 
used. The plate layout position will automatically fill in the number 1.  
For analysis using HPLC vials the configuration is “54VialPlate”. Click in 
row 2 and it will automatically fill in the plate type used in row 1 and set 
the plate layout position as 2.  Click “Ok” → “Next”. 

5. In the “Set Location of Standards” window  

(a) Select the radio button for “At start of sample set”.  In the “Start loading 
vials in tray position:” set to “1:A,1”.  Click “Next”. 

6. In “Specify Calibration Options” window, ensure the radio button for “Each 
standard vial contains a different level standard” is selected → “Next”. 

7. In the “Describe Standard Bracket” window 

(a) Fill in the number of samples set for the number of standards to be 
used. This should be your EQ + the samples of your calibration curve.  
NOTE: For EQ plus S and T series, the number is 11 and for EQ plus 
only S series the number is 6. 

(b) Number of injections = 1. 

(c) Injection volume = 20.0. 

(d) Run time = 9.5. 

(e) In the “Method Set” select the one titled “As_HPLC1_DRC”. 

(f) Click “Next”. 

8. In the “Describe Samples:” window 

(a) Fill in the number of samples for the number of QC, blanks, and 
samples to be used.   

(b) Number of injections = 1. 

(c) Injection volume = 20.0. 

(d) Run time =9.5. 

(e) In the “Method Set” select, the one titled “As_HPLC1_DRC”. 

(f) Click “Next”. 

9. In the “Identification” Window, all options for “How should your standard be 
identified?” will be grayed out. 

Urine arsenic speciation 
NHANES 2019-2020

41 of 101



(a) Leave “SampleName” as Std. 

10. In the “How should your samples be identified?”  Options are as follows. 

(a) Leave the “Area_Correction” as “None” → “Next”. 

(b) Leave the “Blank_Correction” as “None” → “Next”. 

(c) Leave “Column Name” empty → “Next”. 

(d) Leave “Column Serial Number” empty → “Next”. 

(e) Leave “Sample Matrix” empty → “Next”. 

(f) Leave “SampleName” as Unk.  Leave incrementing prefix and suffix 
empty. → “Next”. 

11. In the “Describe Runtime Options”  

(a) Select the radio button for “Run and process”. 

(b) Leave “Interactive system suitability:” as “Continue on fault”. 

(c) Click “Next”. 

12. Review the information in the “Summary” window.  If correct, select “Finish”. 

13. The “Component Editor” window pops up. 

(a) At the top of the window, select “Copy from the Process Method”. This 
will populate the “Component” column. 

(b) The “SampleSet Type” drop down should have “STANDARDS & 
UNKNOWNS” selected. 

(c) In the row for “ISTD” put the value of 1.0 for all columns title 
“Value(Standard) or Value(Unknown). 

(d) For AC, AB, AsIII, DMA, MMA, and AsV fill in the component editor 
table as below in TABLE 9-12.  NOTE: For this part, all fields for TMAO 
are blank. 

(e) For TMAO fill in the next 5 columns.  See TABLE 9-13. 

(f) The “Value (Unknown)” columns should only have “1.000000” in the 
ISTD row. 

(g) Click “OK”. 

(h) Your wizard input will now populate the “Sample Set Method” Table at 
the top of the “Quickstart” screen.   
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TABLE 9-12.  S Series Calibrators 

 Component  Value 
(Standard) 

 Value 
(Standard) 

 Value 
(Standard) 

 Value 
(Standard) 

 Value 
(Standard) 

 ISTD  1.000000  1.000000  1.000000  1.000000  1.000000 

 AC  0.000000  2.000000  10.000000  50.000000  150.000000 

 AB  0.000000  2.000000  10.000000  50.000000  150.000000 

 TMAO           

 AsIII  0.000000  2.000000  10.000000  50.000000  150.000000 

 DMA  0.000000  2.000000  10.000000  50.000000  150.000000 

 MMA  0.000000  2.000000  10.000000  50.000000  150.000000 

 AsV  0.000000  2.000000  10.000000  50.000000  150.000000 
 

TABLE 9-13. S and T Series Calibrators 
Component  Value 

(Standard) 
Value 
(Standard) 

Value 
(Standard) 

Value 
(Standard) 

Value 
(Standard) 

Value 
(Standard) 

ISTD Note: There are 1.000000      

AC 4 preceding 150.000000      

AB columns for  150.000000      

TMAO “Value (Standard)”  0.000000 2.000000 10.000000 50.000000 150.000000 

AsIII that have been 150.000000      

DMA excluded from this 150.000000      

MMA table due to space  150.000000      

AsV limitations. 150.000000      

14. In the “Sample Set Method” make the following edits, 

(a) Change the “# of Injs” to 5 and the “SampleName” to EQ for the sample 
in row 2. 

(b) Change the “Label” to STBlank and the “SampleName” to S0 for the 
sample in row 3. NOTE: Correct spelling and capitalization is critical to 
ensure that this sample is used as the standard blank. 

(c) For all subsequent standards, change the “SampleName” to S1, S2, 
etc.   

(d) For the first unknown sample, ensure the “Label” and “SampleName” 
column read BLANK. NOTE: Correct spelling and capitalization is 
critical to ensure that this sample is used as the sample blank. 

(e) The sample ID list including all subsequent blanks and QC can be made 
using the “ELAN Sample Naming Wrksht”. 

(i) Once the naming worksheet is done copy the column “Sample ID”. 
(ii) Paste in information in by clicking on the first “Unk” cell after the 

“BLANK”. 
(f) Add two rows by clicking on the row after your last Bk sample. 
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(i) In the first, change “SampleName” to “WASH”, The “Method
Set/Report Method” to “As_HPLC1_DRC_WASH), “Run Time
(Minutes)” to 20.00, ensure there is an empty vial in the tray position
of the WASH sample.

(ii) In the second row, change the “Method Set/Report Method” to
“SHUTDOWN_CDC)”.  NOTE: The Plate/Well position for the
shutdown method should be the same as the wash sample.

(g) Save the Sample Set Method by clicking “File” → “Save Sample Set
Method As…” → Filename should be “Vials S&T” or “Vials S only”.
NOTE: If opening one of the templates go through the “Save as”
procedure again using Filename “AsYYMMDD”.

10. INSTRUMENT START UP, ANALYSIS, AND SHUT DOWN

a. HPLC–ICP-DRC-MS System Connection and Startup

(1) Interfacing the HPLC Column to the ICP-DRC-MS Nebulizer
1. Turn off the ICP-MS plasma if it is on.

2. Remove any non-HPLC tubing that may have been installed in the nebulizer.

Connect the HPLC column effluent tubing (coming from port #3 of switching
valve #1) to the ICP-DRC-MS nebulizer/spray chamber assembly as shown
below.

Important! 
Inspect the tubing-nebulizer interface. It is important that there is no gap between the end of the 
HPLC tubing and the portion of the nebulizer where it abruptly narrows to a capillary tube. Small 
gaps can contribute significantly to chromatographic peak broadening and tailing.  

(2) Priming the HPLC Pump on the Agilent System
1. If it has not already been done, place each mobile phase reservoir tubing into

the correct reservoir bottles (i.e. place end of tubing “A” into the bottle
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containing HPLC Buffer A, and end of tubing “B” into the bottle containing 
HPLC Buffer B).  Reservoir tubing “D” is placed into a bottle containing 5% 
acetonitrile in water.     

2. Open the purge port by turning the black knob on the pump counterclockwise 
~¼ to ½ turn. 

3. From the run samples screen in Empower Quickstart, right-click in the “Quat. 
Pump” HPLC control window and select “Method”. 

4. In the section labeled “Flow change 0.000 mL/min to 1.000 mL/min. The pump 
will first initialize and then go to “On” mode. 

5. Click “ok” to return to the run samples screen. 

6. Allow the pump to purge at 100% A until all bubbles are flushed out of the 
tubing. 

7. Once A has purged, right-click in the “Quat. Pump” HPLC control window and 
select “Method”. In the “Solvents” section change B: 0.0% to B: 100.0%. 

8. Click “ok” to return to the run samples screen. 

9. Once buffer B has purged right-click in the “Quat. Pump” HPLC control window 
and select “Method”. Change B: 100.0% to 0.0%. Change the “Flow” from 
1.000 mL/min to 0.000 mL/min. Click “Ok” to return to the run samples screen. 

10. Close the valve (turn the knob clockwise). 

(3) Adjusting the Peristaltic Pumps 
1. Check the external peristaltic pump’s tubing for signs of wear. Flattening of the 

tubing is indicative of excessive wear. Excessively worn tubing must be 
replaced.  

2. If necessary, install new large diameter white-black two-stop peristaltic pump 
tubing on the bottom channel of the external peristaltic pump that controls the 
draining of the spray chamber. If the pump is rotating clockwise, connect the 
left end of the white-black tubing to the tubing that empties the ICP-MS’ spray 
chamber. Connect the right end of the “white-black” tubing to the Tygon waste 
line that leads to the large liquid waste carboy. Close the channel clamp. Do a 
preliminary tightening of the peristaltic pump channel’s tension clamps on the 
“white-black” pump tubing. Later, when you are able to observe liquid actively 
draining from the spray chamber, you will make further adjustments to the 
tension clamps so that the spray chamber will properly drain without applying 
excessive pressure on the tubing.  

3. On the peristaltic pump that controls the internal standard flow, install new 
black-black two-stop peristaltic pump tubing on the top channel and close its 
clamp. Note that the peristaltic pump will rotate counterclockwise. Into the right 
end of the black-black peristaltic tubing, insert the free end of the tubing that 
will draw Internal Standard solution (i.e. the one that will come from the Internal 
Standard bottle). Into the left end of the black-black peristaltic tubing, insert the 
tubing that will carry Internal Standard to Port #6 of switching valve #1 (see 
TABLE 8-1-A).   

4. On the instrument peristaltic pump, install new black-black pump tubing and 
close the clamp. Note that the peristaltic pump will rotate counterclockwise.  
Into the bottom end of the black-black tubing, insert the end of the sampling 
probe that will draw daily solution. Into the top end of the tubing, insert the 
tubing that will carry daily solution to port #3 of switching valve #2 (see TABLE 
8-1-B). 
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b. ICP-DRC-MS Warm Up and Performance Check  

1. Perform a pre-ignition check of the ICP-DRC-MS according to PE 
recommendations specified in the manual.   

2. Launch the NexION® Syngistix for ICP-MS program and note whether all 
graphical indicators of instrument readiness are green. If not, take the 
appropriate actions described in the instrument’s software and hardware 
manual.  

3. Perform necessary daily maintenance checks as described in Chapter 2 of the 
NexION® 300 ICP/MS System Maintenance Guide (e.g., argon supply, 
interface components, cleanliness, positioning, and interface pump oil 
condition). Note the base vacuum pressure in the INSTRUMENT window of the 
software.  (Before igniting the plasma, the vacuum is typically between 8 x 10 -7 
and 1.8 x 10 -6 torr). Keep a record of any maintenance procedures along with 
the base vacuum pressure in the Daily Maintenance Checklist logbook.  

4. Start the external peristaltic pump that controls the waste coming from the 
spray chamber by pressing the appropriate arrow on the peristaltic pump 
control panel. Press either the up or down arrow keys to adjust the peristaltic 
pump speed to approximately “6.25 or greater”. Ensure that the direction of 
rotation is correct so that the spray chamber is being drained and that waste 
liquid will go to the waste container.  

5. In the INSTRUMENT window of the NexION® software, click the “Main” tab and 
click the plasma “Start” button to ignite the plasma, or alternatively in Empower 
Quickstart in the RUN SAMPLES window click on “Turn Plasma On” in the 
NexION ICP-MS section. In the Syngistix INSTRUMENT window, the ignition 
sequence bar (blue progress bar) will start to expand to the right, indicating the 
approximate time before plasma ignition. Before the bar reaches its end, look 
at the spray chamber on the ICP-MS and watch for plasma ignition. Proper 
ignition will occur suddenly and with a single audible “pop”. A bright white light 
will emanate from the injector assembly that connects to the spray chamber.  
The light may at first flicker, but it will establish a more or less steady intensity 
after 5–10 seconds unless a problem exists with the system.  

 

On a rare occasion, the plasma may ignite emitting an orange, violently flickering light, and 
electrical discharge noises will be heard.  In this case, immediately shut off the plasma by 
pressing the button next to the photo depicting a plasma on the ICP-DRC-MS instrument’s 
front control panel.  Wait 30 seconds then investigate the cause of the plasma misfire.    

6. On occasion, the plasma may extinguish a few seconds after ignition.  
Promptly reignite by pressing the “Start” button on the ICP-DRC-MS 
instrument’s front control panel. Usually, the plasma will stay lit after the 
second try, but if not, investigate the cause of the plasma instability (refer to the 
NexION® 300 ICP/MS System Maintenance Guide). 

7. Soon after the plasma ignites, place the sample probe (the one connected to 
the instrument peristaltic pump’s “black-black” tubing, PerkinElmer® P/N B300-
0161) into the daily performance check solution. In The NexION® software, 
click the “Devices” tab and set the speed on the peristaltic pump to 
approximately 20 if the pump fails to start when the plasma is lit. Watch the 
tubing that drains the spray chamber for a half minute or so. If the tubing is 
filling with liquid and you do not see bubbles being carried away from the spray 
chamber drain (and especially if you see liquid starting to rise within the spray 
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chamber) immediately remove the sample probe from the rinse solution.  
Check that the peristaltic pump is rotating in the proper direction so that the 
spray chamber is draining. If not, immediately correct the direction of rotation 
on the peristaltic pump. Next, tighten the thumb screw on the tension clamp of 
the peristaltic pump about ¼ turn. Examine smoothness of flow of liquid 
draining from the spray chamber. If there is no liquid flow or if it continually 
“starts and stops”, tighten the thumb screw again. Keep tightening the thumb 
screw until large bubbles flow through the drain line at a consistent pace. Now, 
slowly loosen the thumb screw until the flow stops or becomes hesitant. Make 
one final adjustment by tightening the thumb screw ½ turn. At this point, the 
tension on the peristaltic pump tubing will be correct, unless a problem exists.  
Re-insert the sample probe into the rinse solution.  

8. Repeat the preceding steps for adjusting the tension clamp for the “black-
black” tubing on the channel if the flow is not steady and consistent.  

9. Let the ICP-DRC-MS warm up for 30-45 minutes.   

10. The following step is for the initial method setup only: 

(a) While the instrument is warming up, in the NexION® program window 
titled “Instrument Control Session”, choose menu item Review. Click the 
“Load” button for “Conditions”, the sixth item on the list. Navigate to the 
folder “C:\Users\Public\Public Documents\PerkinElmer 
Syngistix\ICPMS\Conditions” and click on “as_hplc.dac” file then click 
the “Open” button. Return to Review and click the “Load” button for 
“Method”, the first item on the list. Navigate to the folder 
“C:\Users\Public\Public Documents\PerkinElmer 
Syngistix\ICPMS\\Method” and click on “Daily Performance.mth” file 
then click the “Open” button. Add a new line for arsenic “As” in the 
Quantitative Analysis Method window.  Set the Dwell Time to 50. Do a 
File > Save and save the edited method as “As_HPLC_daily.mth”. Click 
on the Sampling tab and uncheck “Peristaltic Pump under Computer 
Control”. Return to the Timing tab. 

11. After warm-up, complete the appropriate daily optimization procedures as 
described in Chapter 4 of the NexION® Software Guide. Include beryllium (m/z 
9) in the mass calibration and use the mass calibration solution containing 10 
µg/L beryllium if a mass calibration is needed. Complete the autolens 
optimization and daily performance check by using a 1 µg/L multi-element 
solution that includes 1 µg/L of arsenic. Instrument response for 1 µg/L arsenic 
will give counts >2000 cps (in Standard Mode) when the instrument is properly 
optimized.  Fill in the Daily Maintenance Checklist in the instrument logbook 
according to the completed optimization procedures. If a tuning (mass-
calibration) procedure was done, save it to the file “default.tun,” and also in a 
separate file containing the analysis date “default_MMDDYY.tun” (where 
MM=month, DD=day, and YY=year). Save the new optimization parameters 
(i.e., torch alignment, autolens values, nebulizer gas flow rate, and deflector 
voltages) to the file “As_HPLC.dac”. 

12. Also perform a daily performance check in DRC™ mode to record the arsenic 
counts that you receive. Record the DRC™ arsenic counts on the Daily 
Maintenance Checklist. Refer to section 10 c. 

13. If an HPLC analysis is to be run the same day, you may leave the plasma on 
until it is time to convert the nebulizer to interface with the HPLC. If not, press 
“Stop” on the NexION® control panel to turn off the plasma. 
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c. Turning on the Reaction Cell Gas 

1. Flush the cell gas for 20 seconds by lifting the lever on the right side of the 
instrument. 

2. Start the flow of the reaction-cell gas (10% hydrogen, 90% argon) and allow 
the cell conditions to equilibrate. Make sure the regulator on the reaction-cell 
gas cylinder is set to 5-7 psi.   

3. Click on the “Manual Adjust” tab of the “Conditions” window and choose “DRC” 
from the drop menu under Mode.  

4. Monitor the flow on the mass-flow controller by clicking on the “Diagnostics” tab 
of the INSTRUMENT window of the NexION® program and in the filter drop 
down menu, select “Gas Flow Control”. Look for a field labeled “Cell Gas A”.  
The flow will reach approximately “0.6*” within 10–15 seconds. If possible, 
allow 30 minutes for the cell to equilibrate before beginning analysis, with the 
cell gas flowing at 0.6 mL/min*. Note: The cell gas will automatically turn off 
after 45 minutes if the analysis has not begun. 

*Or the DRC™ gas value that is found to be optimal. 

5. Once the cell gas has warmed up, perform a DRC™ neb gas optimization and 
a deflector voltage optimization. Update the values if needed. Perform a 
DRC™ Mode Daily Optimization Check and record the results in the Daily 
Maintenance Checklist.  

6. Save the new optimization parameters to the file “As_HPLC.dac.” If needed, 
save it again to a new file named “default <yymmdd.dac>” (where yy=year, 
mm=month, and dd=day; do not include the brackets in the file name). 

7. Place the free end of the tubing that will carry the internal standard into a bottle 
containing 1 liter of the Internal Standard solution. 

d. Entering Sample Names into the Empower Quickstart Sample Set Method  

1. Click on the Run Samples tab on the left-hand side of Empower Quickstart. If 
the current Sample Set Method is not this run’s sample set, then choose File > 
New Sample Set > Using Sample Set Method… on the menu bar and navigate 
to and open this run’s current data folder in the Sample Set Method window.  
Click on the file named “As<yymmdd> (yy = year, mm = digit month, dd = date) 
and open it. The Sample Set Method window will be the one created in the  
Creating the Empower Sample Set Method  section.   

2. Fill in the name of each sample by double-clicking in the “SampleName” cell 
matching its “Plate/Well” location. Use a barcode scanner to input the sample 
name and press “Enter” on the keyboard. In this manner, enter the name of 
every blank, calibrator, quality control, and sample that will analyzed in the run.   
Alternatively, a Sample Set Method template saved in Empower can be used to 
create a sample list, which puts each sample into the correct autosampler 
formatting to help reduce error. 

3. Keep the following in mind while filling out the Samples table.  

(a) Autosampler tray position 1:A,1 will contain the vial containing a low bench 
QC sample called “EQ”, which will be injected with five replicates during the 
initial system equilibration period before the start of calibration. “EQ” is not 
used for QC but is strictly for equilibrating the HPLC and conditioning the 
ICP-DRC-MS.   
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(b) Autosampler tray position at the end of the sample run needs to contain a 
blank vial (even an empty vial will do). NOTE: This will change from run to 
run if the number of samples analyzed is different from previous days. 

(c) Insert a “Bk” between the equilibrators and S0. Also insert blank checks 
throughout the run as needed to show that carryover is not occurring.  

(d) No more than 24 hours can elapse between the time that the actual 
analytical run starts (the analysis of S0) and the analysis of the last vial is 
complete. Keep this in mind when determining how many samples will be 
analyzed. 

4. For example, in a run of 15 samples, the last vial ends up being placed in 
Plate/Well position 1:D,8. Of course, the actual position of the last sample 
depends on the total number of vials in the autosampler tray. Note: if more than 
one group of samples is to be analyzed, each group needs to be bracketed by 
its own QC. In some instances, on the sample table this rule will result in four 
QC samples being run in succession (for instance, LU-xxxx, HU-xxxx, LU-xxxx, 
HU-xxxx). Be sure to delete all unused rows after the last vial in the Sample 
Set Method window, i.e. clear all rows after the last row by selecting them, 
right-clicking and select “Delete”. NOTE: As stated in the Creating the 
Empower Sample Set Method section be sure that the last two rows have the 
same Plate/Well designation and an empty vial is in the autosampler tray.   

5. When satisfied that the Sample Set Method table entries are correct, choose 
File > Save. 

 

e. Starting the Run  

1. Check the waste container.  If more than two-thirds full, discard of the waste 
using the protocol outlined in SOP DLS 3500 Handling Corrosive Liquid 
Laboratory Waste.  

2. Ensure that the tubing that draws internal standard is inserted into the bottle 
containing internal standard and that there is a sufficient amount of solution to 
complete the run. 

3. Ensure that there is sufficient mobile phase to last the entire run. In addition, be 
sure that Bottle D and the HPLC Autosampler’s wash bottle contains sufficient 
amount of 5% (v/v) acetonitrile. It is very important that line D does not become 
filled with air bubbles at any point during analysis.  

4. Set the 1260 Column Oven to 35°C if it is not already at that temperature.  
Verify that the HiP ALS temperature is set at 4°C. Both can be checked in 
Empower Quickstart in the HPLC control windows of “Column Comp.” and 
“HiPSampler”, respectively. 

5. Launch Syngistix for ICP-MS® Instrument Control program if it is not already.  
Do not launch or start any other programs at this time. 

6. Check that the correct Sample Set Method file in the window Run Samples 
Sample Queue” is active. If it is not correct, load the correct Sample file. Check 
that the correct Empower method is loaded and active in the window “Run 
Samples > Sample Queue”. If it is not correct, load the correct Method file.  

7. Check that the DRC™ gas is indeed flowing by making the NexION®’s 
Instrument window active and clicking on the Diagnostics tab. Inspect the Cell 
Gas A.  Its value will be fluctuating around 0.6 (or other optimal value) ± 0.01 
mL/min. If it is not, see section Turning on the Reaction Cell Gas for details to 
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turn on the DRC™ gas flow. Make the conditions window active and Choose 
File > Save to save the method file.  

8. Check that all blanks, calibrators, QC and sample vials are loaded into their 
correct positions in the HPLC autosampler tray, as designated by the run’s 
Sample Set Method. 

9. Open the “View Acquisition” tab on the left hand side of Empower Quickstart, 
click the icon of three test tubes with a green play button to start the run. 

10. If the HPLC pump is not already pumping, Empower Quickstart will start the 
flow of buffer A. This will start the prerun on the HPLC control window. NOTE: 
There is no run time displayed during the pre-run. 

11. Open the NexION® “Instrument Control Session” Real-Time window by clicking 
the tool bar button that looks like a Gaussian distribution (burgundy 
chromatographic peak).  After the Real-Time window opens, click on the drop-
down menu and select “Signal”. Real-time data will now be displayed. Real 
time data is also displayed in the View Acquisition window of Empower 
Quickstart. 

12. When the HPLC pump’s equilibration time has been reached, the autosampler 
will seek the first vial and make an injection. The HPLC controls will switch to 
all green status bars and show the current run time for the sample in Empower 
Quickstart. The system can now run unattended.  

13. Check the progress of the run after 2 or 3 injections. Note the chromatograms 
appearing in the NexION®’s Real Time window. Adjust the signal scale in the 
Real Time window, as necessary. Compare the positions and peak heights of 
each arsenic species relative to the internal standard. It helps to visually 
compare it to a printed reference chromatogram. If abnormalities in retention 
time, peak height or shape are readily apparent, the analyst may need to stop 
the autosampler and pump and abort the run in the Empower Quickstart 
program. To do this click the icon of three test tubes with a red stop button.  
The HPLC pump is stopped by right-clicking in the “Quat. Pump” window of the 
HPLC control and selecting “Method”.  Change the “Flow” from 1.000 mL/min 
to 0.000 mL/min.  Click “Ok”.  Correct the problems(s) and restart the run. 

f. Instrument Shut Down 

1. Shut off the ICP-DRC-MS plasma if it has not already been done.  Stop all 
peristaltic pumps and loosen tensioning bars and tubing.  

2. Check that the HPLC autosampler controller readout indicates that the 
sequence was successfully completed.  If not, note the message and 
investigate the reason for the message (i.e. sample vial was missing). 

3. At the instrument computer, check the Sample Set Method and confirm that all 
samples were analyzed. 

4. Remove the calibrator, QC and sample vials from the HPLC tray. Discard them 
according to CDC biohazard waste disposal guidelines. 
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11. POST-RUN DATA ANALYSIS 

a. Configuration of Empower Quickstart Processing Method 

The following information is presented as a starting point to help the analyst develop 
robust integration method parameters that will work best for most chromatography 
data. Many of these parameters will work just fine as presented below.  However, the 
separation chemistry of HPLC columns can vary due to frequency of use, column 
replacement, or because of individual sample “oddities”. Some parameters may need 
to be adjusted from time to time to maximize the ability of Empower to properly 
integrate peaks and identify components with minimum operator intervention.  
Therefore, the analyst must pay particular attention to the chromatograms produced 
in every run and make necessary adjustments as warranted. The creation of a new 
processing method in Empower is done the first time by a PerkinElmer technician.  

1. Choose the left hand menu item View Method > Processing. Click on the 
“Integration” tab in the “Processing” window. Enter the information shown in 
TABLE 11-1. The analyst may make appropriate changes to one or more of the 
Integration parameters if necessary. 

 

TABLE 11-1: INTEGRATION 

Integration 
Algorithm ApexTrack 

 
 Peak Integration  

    Liftoff %: 0.000 
Apex Detection    Touchdown %: 0.500 
Start (min): 0.227   Minimum Area: 200 
End (min): 10.153   Minimum Height: 50 
Peak Width (sec): 8.98     
Detection 
Threshold: 

6.400e+000  Time 
(min) 

Type Value 

   0.000 Set Peak Width (sec) 60.000 
   1.000 Set Peak Width (sec) 18.770 

 

2. Click on the “Smoothing/Offset” tab. As a guideline leave the information in the 
tab on the default. 
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3. Click on the “Components” tab. As a guideline, enter the information shown in 
TABLE 11-2.  Be sure there is a checkmark in the box for “Include Internal Std 
Amounts in % Amount Calculation”. The parameters in TABLE 11-2 are 
starting points. The analyst may make appropriate changes to one or more of 
the Components parameters if necessary. 

 

TABLE 11-2: Components 
Average By: None    Update RT: Never    
RT Window (%): 6.00    CCalRef1: ISTD    
Sample Value Type: Concentration   RT Reference Used to Name Unnamed 

Peaks by RRT: 
Empty    

           
Name Retention 

Time 
(min) 

RT Window 
(min) 

Peak 
Match 

Channel Y Value X Value Fit Weighting Internal 
Std 

Impurity 
RRF 

ISTD 0.635 0.353 Closet As75 Corrected_Area Corrected_Concentration Linear None   
AC 1.327 0.077 Closet As75 Corrected_Area Corrected_Concentration Linear None ISTD 1.000 
AB 1.665 0.042 Closet As75 Corrected_Area Corrected_Concentration Linear None ISTD 1.000 
TMAO 1.782 0.035 Closet As75 Corrected_Area Corrected_Concentration Linear None ISTD 1.000 
AsIII 2.195 1.000 Closet As75 Corrected_Area Corrected_Concentration Linear None ISTD 1.000 
DMA 3.392 1.000 Closet As75 Corrected_Area Corrected_Concentration Linear None ISTD 1.000 
MMA 6.735 2.000 Closet As75 Corrected_Area Corrected_Concentration Linear None ISTD 1.000 
AsV 8.443 0.750 Closet As75 Corrected_Area Corrected_Concentration Linear None ISTD 1.000 

 

4. Leave all default information for the tabs “Impurity”, “Peak Ratios (MS Ion 
Ratios)”, “Default Amounts/Purity”, “Named Groups”, “Timed Groups”, and 
“Noise and Drift”. 
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b. Data Processing and Analysis 

Refer to Figure 1 below “Post-Run Data Processing Work Flow Diagram” for a 
summary representation of the important aspects of post-run data processing.  

Figure 1: Post-Run Data Processing Work Flow Diagram 

 

 

1. Open “Quickstart” and click on “Browse Project”. Click on “Result Sets” tab if 
not already selected then “Update” in the top tool bar. This will refresh the list 
of result sets and include the last set analyzed on the system. 

2. Highlight the “Result Set Name” for reprocessing →right – click “Review”. In the 
resulting “Replace” window click “Yes”.  Click on “Injection 1” of the EQ sample 
drop down on the left side of the screen. In the top toolbar, click “Next injection” 
to go through all samples to check for peak identification.   

3. For S0 and T0 (when applicable) analyst must manually integrate for all 
applicable peaks not detected by the software. This will ensure each calibration 
curve has the required five points. Zoom in as needed on the chromatogram 
and manually integrate on the baseline for AC, AB, AsIII, DMA, MMA, and AsV 
on S0 as needed.  Repeat on the T0 chromatogram for TMAO only. To zoom 
out right click →“FullView”. Click the icon for “Show components” to remove the 
indicators. NOTE: When changes are made to any chromatogram once done, 
immediately go to File → Save → “Result”. Do not move to the next 
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chromatogram without doing this and do not select any option enabled except 
“Result”.   

4. Click on “Browse Project” on the left side. Highlight the “Result Set Name” 
being reprocessed → Right-click →Click “Process”. In the window “Background 
Processing and Reporting” in the “Processing” section. Check “Clear 
Calibration” and “Use Existing Integration” if not already done.  For “How” 
select “Calibrate and Quantitate” from the drop down if not already selected. 
Then click “Ok”.  Wait 30 seconds and then click “Update” at the top.  A new 
Result Set Name line will appear above the previous one that was being used 
for processing.   

5. Highlight the new “Result Set Name” → right-click → select “Review”.  The 
result set with S0 and T0 integration is now loaded.   

6. Check the calibration curves for each species. In the top toolbar click on the 
icon that looks like a liquid drop with a line through it for “Calibration Curve”. In 
the new window, select each species from the “Component” drop down. Verify 
the following: 

(a) There are five points per curve. 

(b) The correlation coefficient (R2) is 0.99 or higher. 

(c) Slopes range from 9.0 x 10-3 to 1.3 x 10-2. 

7.  Check chromatograms for QC and samples. Make adjustments as needed.  
NOTE: When changes are made to any chromatogram once done, 
immediately go to File → Save → “Result”. Do not move to the next 
chromatogram without doing this and do not select any option enabled except 
“Result”.   

8. To export the results go back to “Browse Project” → “Results Sets” tab → right-
click on the “Result Set Name” desired →“Export”. In the “Exporting” section of 
the “Background Processing and Reporting” →check “Export” → select the 
radio button for “Use specified export method” if not already selected.  In the 
drop down, select “Export basic_Final conc” → Click “Ok”. 

9. Open Excel. In Excel, select “File” → “Open”.  Navigate to the C: drive → 
“HPLC” folder→ “Data” folder. Change “All Excel Files” to “All files” in the drop 
down menu. Sort by date modified and select the export file with a filename 
exportXXXXX (this file is a text file). NOTE:  The XXXXX will change based on 
the file selected for export in Empower but will always be five numbers. Click 
“Ok”.   

10. In the “Text Import Wizard” window. Select the radio button for “Delimited” → 
“Next”.  Uncheck the box for “Tab” and check the box for “Comma” → next.  
Click “Finish” on the last window. The file for your Empower results opens. 

11. Save this file with the filename format of AsYYMMDD Results to the 
corresponding run folder on the C: drive. Cut and paste export file from the C: 
into proper run folder for the day.   

12. To print one PDF file of all sample chromatograms go back to “Browse Project” 
→”Results Sets” tab → right-click on the “Result Set Name” desired →“Print”.   

13. In the “Reporting” section of the “Background Processing and Reporting” 
→check “Print” → select “pdfFactory Pro” from the drop down menu → select 
the radio button for “Use specified report method” if not already selected. In the 
drop down, select “Arsenic Speciation” → Click “Ok”. 

14. pdfFactory Pro will open and compile the file. Save the file, with the format 
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AsYYMMDD Report, to the corresponding run folder for the day on the C: 
drive. 

15. To print one PDF file of all calibration curves go back to “Browse Project” →the 
“Curves” tab → highlight all of the analyte calibration curves → right-click 
→“Print”.   

16. In the “Reporting” section of the “Background Processing and Reporting” 
→check “Print” → select “pdfFactory Pro” from the drop down menu →, click 
“Ok”.  In the drop down, select “Arsenic Speciation” → Click “Ok”. 

17. pdfFactory Pro will open and compile the file. Save the file, with the format 
AsYYMMDD Calibration Report, to the corresponding run folder for the day on 
the C: drive. 

18. The data processing portion on the instrument controller computer is now 
complete.  

12. RECORDING OF SAMPLE AND QC DATA 

a. Transferring the Data to the LIMS  

1. Transfer the entire folder labeled “As<yymmdd>” via encrypted USB drive or 
other data media to the appropriate subdirectory on the network drive where 
exported data are stored.  (Note that directories are named according to 
instrument\year\month\ for example,  

“\..........\Nutritional\Instruments\NexION\NexION - G\2013\As130110” 

2. Use the current “Speciation Lab Parsing Application” file to convert the file 
saved in section 11 b.11 to a multi-tabbed Excel workbook suitable for data 
exportation to the LIMS.  

3. Import the instrument file into the laboratory information management system 
with appropriate documentation (e.g. instrument ID, analyst, calibration 
standards lot number, and run or sample specific comments). 

4. Save all instrument data for that day on the shared network drive.    

b. QC Data 

Once data is transferred to DLS STARLIMS, quality control (QC) samples must be assessed for 
pass or failure through the generation of QC reports.  The QC reports are stored electronically. 

13. FINAL REVIEW OF THE DATA 

a. Run Data 

Instead of printing the data onto paper, it should be stored as a PDF that can be 
reviewed. If the samples analyzed are part of a study that has an associated study 
folder, indicate the shared drive location of the electronically stored data. 
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b. Plotting QC Results 

Importing data into DLS STARLIMS allows for the capture of quality control data that 
can be monitored through the generation of statistical quality control plots using SAS.  
The analyst must monitor these plots regularly for any trends in the bench QC results.  
If trends are observed, contact the laboratory supervisor, and investigate the cause of 
the trend(s). The QC results for a particular method must also be reviewed periodically 
by the team leader or lab chief to verify that trends in the data do not exist. 

c. Supervisor Review 

DLS STARLIMS allows a person with supervisory authority to review the QC and 
sample results in the system (electronically). After the supervisor reviews the data, he 
or she may release the data for reporting. 

14. QUALITY CONTROL PROCEDURES 

The Inorganic and Radiation Analytical Toxicology Branch uses the method described in this 
protocol for environmental and occupational health screening studies.   

The analyst inserts bench QC samples at the beginning and end of each analytical run (a set of 
consecutive assays performed without interruption) so that judgments may be made on the day of 
analysis. Taking these samples through the complete analytical process exposes them to the 
same treatment and conditions as the patient samples. The data from these QC materials is then 
used to estimate methodological imprecision and to assess the magnitude of any time-associated 
trends.   
 
The bench QC pools used in this method comprise two levels of concentrations spanning the 
“low-normal” and “high-normal” ranges for each arsenic species. Both of these pools are 
analyzed after the calibration standards are analyzed but before any patient samples are 
analyzed. These bench QCs will be analyzed again at the end of the run. If a second run of 
samples are analyzed using the same calibration curve as the first run, the QC results obtained 
from the second run’s own bench QC samples need to be analyzed and treated independent of 
the first run. 
 
 

a. Establish QC limits for each QC pool.   

A run to assess the homogeneity of the pools is performed after the pools are aliquotted into 
individual vials. Vials are randomly chosen and randomly analyzed, and the first and last vials 
dispensed are always included in the homogeneity study. Unlike the characterization of the QC, 
the homogeneity study can be completed in a single run. Once analysis is complete, the data is 
evaluated in terms of QC recovery to determine whether or not trends exist in QC during the 
dispensing of the pool. If the pool does not vary from beginning to end, characterization of the QC 
pool is the next step. If problems exist, identify the source(s). The pool has to be re-made and 
dispensed again unless problem vials can be identified and eliminated.   

To complete the characterization that will allow you to assess limits for each pool, analyze a 
minimum of forty samples of each pool (one at the beginning of the run and one at the end of the 
run) on 20 different runs, preferably among all of the instruments that will be used to analyze this 
method. During the 20 characterization runs, QCs from previously characterized pools are also 
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analyzed to evaluate the analytical performance of each run. Once analysis is complete, SAS 
within DLS STARLIMS is used to calculate the mean and standard deviation for each pool from 
the concentration results. The statistical limits for each pool are set using this process. 

b. Precision and Accuracy 

QC Results Evaluation.  After completing a run and reprocessing the data, check the results of 
the QC to determine whether the run is “in control” for each of the seven analytes. The QC rules 
apply to the average of the beginning and ending analyses of each of the bench QC pools. The 
QC rules are as follows: 

1. If both QC run means are within 2Sm limits and individual results are within 2Si limits, 
then accept the run. 

2. If one of the two QC run means is outside a 2Sm limit – reject run if: 

• Extreme Outlier – run mean beyond characterization mean +/- 4Sm. 

• 3S Rule – Run mean is outside a 3Sm limit 

• 2S Rule – Both run means are outside the same 2Sm limit 

• 10 X-bar Rule – Current and previous 9 run means are on the same side 
of the characterization mean 

3. If one of the four individual results is outside a 2Si limit – reject run if: 

(a)  Extreme Outlier – One individual result is beyond the characterization 
mean +/- 4Si. 

(b) R 4S Rule– Within-run ranges for all pools in the same run exceed 4Sw 
(i.e., 95% range limit).  
Note: Since runs have multiple results per pool for 2 pools, the R 4S 
Rule is applied within runs only. 

c. Remedial Action If Calibration or QC Systems Fail to Meet Acceptable 
Criteria 

If an analyte fails to pass QC based upon the QC report, the following steps must be taken, if 
possible:  

• Check the chromatograms for each blank, calibrator, QC, and sample for proper peak 
integration and identification. Check that the internal standard peak was properly integrated 
and identified. Change integration parameters or manually reintegrate peaks, if necessary, 
and reprocess the run.  

• Check the ICP-DRC-MS stability during the run by examining the degree of drift in internal 
standard raw peak areas over the course of the run. Drift >20% or sudden large changes in 
internal standard peak area can indicate a problem with plasma instability. Monitor QC 
recovery to determine if that is the case. 

• If the QC failure is likely attributed solely to the calibrators, the run can be repeated with a 
new set of calibrators using the prepared samples and QC from the original run. This can be 
done only if the two runs (original and repeat) are performed on two consecutive days. If 
more than one day has lapsed since the QC failure was noticed, both the samples and QC 
must be re-prepared.   
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• If using new calibrators does not resolve the issue, further troubleshooting will be needed. All 
samples and QC will need to be re-prepared for a new run if the source of the problem is 
suspected to be the QC or cannot be confirmed. 

• If these steps do not result in correction of the out-of-control values for QC materials, consult 
the supervisor for other appropriate corrective actions. No analytical results will be reported 
for runs that are not within acceptable statistical control limits. 

15. LIMIT OF DETECTION AND LINEAR RANGE TESTED 

The limits of detection (LOD) for arsenic species in urine samples were calculated in accordance 
to the guidelines established by the Division of Laboratory Sciences. The method used to 
calculate the LODs is based on the recommendations of the Clinical and Laboratory Standards 
Institute (CLSI) and take both Type I and Type II errors into consideration. According to the 
guidelines established by our division, at least four concentration levels are to be analyzed in 
each run with one level having analyte concentrations below the projected LOD. For this method, 
the matrix-matched calibration blank was used to satisfy the criterion of having a level below the 
LOD while the first three calibrators of the standard calibration curve were used for the other 
three levels. All samples used for LOD calculations were human urine samples.  Multiple analysts 
were used for the measurements which covered over 60 runs over at least 60 days.   
 
According to division protocol, for linear relationships the following equation is used to calculate 
the LOD:  concLOD = [meanb + 1.645*(sb + B)] / (1-1.645*A) where meanb is the mean of the blank, 
sb is the standard deviation of the blank, B is the y-intercept, and A is the slope. For quadratic 
relationships (y=Ax2 + Bx+C), the following equation is used to calculate the LOD:  concLOD = [-b 
± sqrt (b2 -4ac)] / 2a where a=1.645*A, b= (1.645*B)-1, and c= meanb + 1.645*(sb+C). With both 
linear and quadratic relationships, the resulting calculated LOD has a 5% false negative rate.   
TABLE 15-1 lists the LODs calculated for this method.   
 
As stated in the DLS Policies and Procedures Manual “uncertainty increases as values approach 
the limit of detection.” Division policy prohibits reporting results lower than the lowest calibration 
curve point.  Report results below the detection limit as “< LOD” (where “LOD” is the calculated 
lowest detection limit). The LOD calculation is reevaluated whenever major changes to the 
method occur.  
 
During method development, it was established that the arsenic species were linear up to 1000 
µg/L. 
   

TABLE 15-1: LIMITS OF DETECTION (LOD) AND LINEAR RANGE TESTED (LRT) FOR AS SPECIES  

Species  
Chemical Name 

Abbreviated 
Name 

Limit of 
Detection, µg/L 

Highest  Concentration for 

Linear Range Tested, µg/L 

Arsenobetaine AB 1.16 1000 

Arsenocholine AC 0.11 1000 

Trimethylarsine 
oxide 

TMAO 0.17 1000 

Monomethylarsonic 
acid 

MMA 0.20 1000 

Dimethylarsinic acid DMA 1.91 1000 

Arsenous (III) acid As(III) 0.12 1000 

Arsenic (V) acid As(V) 0.79 1000 
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16. REPORTABLE RANGE OF RESULTS 

When a sample result for any analyte is greater than the highest calibrator for the same analyte 
within the run (150 µg/L but less than 1000 µg/L), the sample needs to be reanalyzed using the 
extended calibration curve. Bracketing elevated QC needs to be analyzed for the extended 
calibration run along with the patient sample that falls within that range. The sample result will be 
reported from that run. The maximum dilution allowed for each analyte is a 1:50 dilution; 
therefore, urine arsenic results are reportable in the range of greater than the LOD up to 50,000 
µg/L.    

If a patient result for a particular analyte is slightly above 150 µg/L when measured with the 
normal calibration curve but falls slightly below 150 µg/L when measured with the extended 
calibration curve, the following measure should be taken. Dilute the sample using the smallest 
dilution factor possible (i.e. dilution factor of 2) and analyze with the normal calibration curve and 
bench QC. If the sample volume is limited, a larger dilution factor can be used, but it cannot 
exceed 50. 

Results Greater Than Range of Linearity Tested: Perform an extra dilution on any urine sample 
whose concentration is greater than the Linear Range Tested (“LRT”) concentration in TABLE 15-
1 (the highest concentration for linear range tested). A 1:50 dilution is the maximum dilution that 
may be performed. 

17. SPECIAL PROCEDURE NOTES – CDC MODIFICATIONS  

None applicable for this method.  

18. LIMITATIONS OF METHOD; INTERFERING SUBSTANCES AND 
CONDITIONS 

The argon chloride (ArCl) interferences on arsenic (75As) are eliminated by the operation of the 
DRC™ under the parameters noted in the sections above during the speciated arsenic analysis. 

19. REFERENCE RANGES 

The reference range for each arsenic species (see TABLE 19-1) is based on literature reports 
and from periodic review of accumulated data collected during the analysis of urine samples 
representing a normal, healthy population believed to be free of unusual exposure to arsenic.  
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TABLE 19-1: REFERENCE RANGES FOR ARSENIC SPECIES  

Species Chemical Name Reference Range1, µg/L  

Arsenobetaine <LOD – 27.6  

Arsenocholine <LOD – 0.440  

Trimethylarsine oxide <LOD  

Monomethylarsonic acid 0.280 – 1.45  

Dimethylarsinic acid 2.85 – 11.8  

Arsenous (III) acid <LOD – 1.12  

Arsenic (V) acid <LOD  

1 Above ranges (50th percentile to 95th percentile) are taken from NHANES population data for the 
2015 to 2016 survey years (2011 to 2012 for TMAO) as provided in the Fourth National Report on 
Human Exposure to Environmental Chemicals, Updated Tables, January 2019.  Sample sizes were 
n=2,517 for trimethylarsine oxide and n=3,094 for all other species. 
(http://www.cdc.gov/exposurereport/) 

20. ACTION-LEVEL RESULTS   

Concentrations for the non-dietary arsenic species - DMA, MMA, As (III), and As (V) - that are 
observed to be greater than the “first upper boundary” (defined in DLS STARLIMS as the “1UB”) 
must be confirmed by repeat analysis of a new sample preparation. The 1UB for these four 
species is 50 µg/L. Report the original result, as long as the confirmation is within 10% of the 
original. Continue repeat analysis until a concentration can be confirmed. 

If a patient sample has a non-dietary arsenic concentration greater than 50 µg/L, the levels will 
have to be reported by fax, telephone, or E-mail to the supervising physician or principal 
investigator. This is done by the reviewer(s) of the data and not the analyst.   

21. SAMPLE STORAGE AND HANDLING DURING TESTING 

Samples may reach and maintain ambient temperature during analysis. Take stringent 
precautions to avoid external contamination.  After the samples are analyzed, return them to 
approximately -70°C freezer storage as soon as possible.  

22. ALTERNATE METHODS FOR PERFORMING TEST AND STORING 
SAMPLES IF TEST SYSTEM FAILS 

If the analytical system fails, freezer storage (approximately -70°C or lower) is recommended until 
the analytical system is restored to full functionality. 
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23. TEST-RESULT REPORTING SYSTEM; PROTOCOL FOR 
REPORTING CRITICAL CALLS (IF APPLICABLE) 

Report test results as outlined in the DLS Policies and Procedures Manual.  For critical calls, the 
supervisor must notify the supervising physician or principal investigator as soon as possible.  
The most expeditious means must be used (e.g., telephone, FAX, or E-mail). 

24. TRANSFER OR REFERRAL OF SAMPLES; PROCEDURES FOR 
SAMPLE ACCOUNTABILITY AND TRACKING 

For select studies, the person that receives samples or samples delivered to the Inorganic and 
Radiation Analytical Toxicology Branch sets up a “Sample Folder.” He or she is to fill out a 
tracking form and place it in the folder to be given to the analyst performing the analysis. The 
form tracks location, status, and final disposition of the samples. When sample analysis is 
completed, update and place the tracking form in the Sample folder.  

Use standard electronic record keeping means (e.g., usage of shared network drives, encrypted 
USB devices, or CD-R backups) to track samples. Keep duplicate records in electronic or hard-
copy format. Use only numerical identifiers (e.g., case ID numbers); all personal identifiers are 
available only to the medical supervisor or project coordinator to safeguard confidentiality. Refer 
to the DLS Policies and Procedures Manual for up-to-date record retention guidelines. 

25. BI-ANNUAL INSTRUMENT-TO-INSTRUMENT COMPARISON 

Per CLIA requirements, if an analytical method is performed on more than one instrument, then 
an instrument-to-instrument comparison has to be performed twice per year. The same samples 
have to be analyzed on each instrument, and the Pearson Product Moment Correlation 
Coefficient for the results for each species has to be greater than 0.95. If not, remedial action has 
to be taken.   

26. METHOD PERFORMANCE DOCUMENTATION 

Method performance documentation for this method including accuracy, precision, sensitivity, 
specificity and stability is provided in Appendix A of this method documentation. The signatures 
of the Branch Chief and Director of the Division of Laboratory Sciences on the first page of 
this procedure denote that the method performance is fit for the intended use of the 
method.   

27. SUMMARY STATISTICS AND QC CHARTS 

Please see following pages. 
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2019-2020 Summary Statistics and QC Chart 
URXUAS5 (Urinary Arsenic acid (µg/L)) 

Lot N 
Start 
Date 

End 
Date Mean 

Standard 
Deviation 

Coefficient of 
Variation 

4959 98 21FEB19 28JAN20 12.2655 0.7545 6.2 
4958 98 21FEB19 28JAN20 6.8140 0.4299 6.3 
6503 23 04FEB20 08JUL20 12.5733 1.0175 8.1 
6502 23 04FEB20 08JUL20 7.5994 0.5849 7.7 
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2019-2020 Summary Statistics and QC Chart 
URXUAB (Urinary Arsenobetaine (µg/L)) 

Lot N 
Start 
Date 

End 
Date Mean 

Standard 
Deviation 

Coefficient of 
Variation 

4959 98 21FEB19 28JAN20 8.579 0.601 7.0 
4958 98 21FEB19 28JAN20 29.335 1.871 6.4 
4960 10 06MAR19 13MAR20 375.125 30.214 8.1 
4961 10 06MAR19 13MAR20 508.380 31.141 6.1 
6503 23 04FEB20 08JUL20 7.220 0.423 5.9 
6502 23 04FEB20 08JUL20 30.215 1.439 4.8 
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2019-2020 Summary Statistics and QC Chart 
URXUAC (Urinary Arsenocholine (µg/L)) 

Lot N 
Start 
Date 

End 
Date Mean 

Standard 
Deviation 

Coefficient of 
Variation 

4959 98 21FEB19 28JAN20 2.378 0.250 10.5 
4958 98 21FEB19 28JAN20 5.172 0.321 6.2 
6503 23 04FEB20 08JUL20 4.491 0.291 6.5 
6502 23 04FEB20 08JUL20 9.062 0.591 6.5 
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2019-2020 Summary Statistics and QC Chart 
URXUDMA (Urinary Dimethylarsinic acid (µg/L)) 

Lot N 
Start 
Date 

End 
Date Mean 

Standard 
Deviation 

Coefficient of 
Variation 

4959 98 22FEB19 28JAN20 11.3044 0.5456 4.8 
4958 98 22FEB19 28JAN20 6.1285 0.3536 5.8 
6503 23 04FEB20 08JUL20 11.9233 0.4584 3.8 
6502 23 04FEB20 08JUL20 5.9394 0.2969 5.0 
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2019-2020 Summary Statistics and QC Chart 
URXUMMA (Urinary Monomethylarsonic acid (µg/L)) 

Lot N 
Start 
Date 

End 
Date Mean 

Standard 
Deviation 

Coefficient of 
Variation 

4959 98 21FEB19 28JAN20 7.3934 0.4294 5.8 
4958 98 21FEB19 28JAN20 3.9480 0.2612 6.6 
6503 23 04FEB20 08JUL20 6.9576 0.4942 7.1 
6502 23 04FEB20 08JUL20 4.1592 0.3458 8.3 
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2019-2020 Summary Statistics and QC Chart 
URXUAS3 (Urinary arsenous acid (µg/L)) 

Lot N 
Start 
Date 

End 
Date Mean 

Standard 
Deviation 

Coefficient of 
Variation 

4959 98 21FEB19 28JAN20 10.8992 0.5882 5.4 
4958 98 21FEB19 28JAN20 6.9796 0.4486 6.4 
6503 23 04FEB20 08JUL20 10.4002 0.3792 3.6 
6502 23 04FEB20 08JUL20 6.5536 0.2408 3.7 
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29. APPENDIX

a. Appendix A:  Method Performance Documentation

Accuracy using Spike Recovery 
Recovery = (final concentration – initial concentration)/added concentration
Recovery should be 85-115% except at 3*LOD where can be 80-120%

Method name:
Method #: 3000
Matrix: Urine
Units: µg/L
Analyte:

Replicate
Spike 

concentration
Day 1 Day 2 Mean

Recovery 
(%)

Spike 
concentration

Day 1 Day 2 Mean
Recovery 

(%)
Mean 

recovery (%)
SD 
(%)

Sample 1 0 0 0 0
2 0 0 0 0 91.7 0.8
3 0.56 0.0 0 0.0

Sample + Spike 1 1 9.7 9.1 14 14
2 9.5 9.1 14 14
3 9.5 9.2 14 13

Sample + Spike 2 1 19 18 23 23
2 19 18 23 23
3 19 18 23 23

Sample + Spike 3 1 28 27 32 32
2 27 27 32 32
3 27 27 32 32

Arsenic Speciation in Urine by ICP-DRC-MS-HPLC

35
32 91.4

15
13.8 92.2

25
23.0 92.0

Sample 2
Measured concentration

0
0.0

Arsenocholine (UASC)

18.5

27

92.6

92.0

0

10

20

30
90.2

Sample 1
Measured concentration

0.1

9.4
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Accuracy using Spike Recovery 
Recovery = (final concentration – initial concentration)/added concentration
Recovery should be 85-115% except at 3*LOD where can be 80-120%

Method name:
Method #: 3000
Matrix: Urine
Units: µg/L
Analyte:

Replicate
Spike 

concentration
Day 1 Day 2 Mean

Recovery 
(%)

Spike 
concentration

Day 1 Day 2 Mean
Recovery 

(%)
Mean 

recovery (%)
SD 
(%)

Sample 1 0 0 0 0
2 0 0 0 0 95.9 3.4
3 0 0.0 0 0.0

Sample + Spike 1 1 10 9.4 15 14
2 9.7 9.4 15 15
3 9.9 9.4 15 14

Sample + Spike 2 1 21 20 25 22
2 20 20 24 22
3 21 20 24 22

Sample + Spike 3 1 30 27 34 32
2 29 27 33 31
3 29 27 34 32

Sample 1
Measured concentration

0.0

9.6

20.3

28

96.3

101.6

0

10

20

30
93.9

Arsenic Speciation in Urine by ICP-DRC-MS-HPLC

35
33 93.3

15
14.7 97.8

25
23.2 92.7

Sample 2
Measured concentration

0
0.0

Arsenobetaine (UASB)
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Accuracy using Spike Recovery 
Recovery = (final concentration – initial concentration)/added concentration
Recovery should be 85-115% except at 3*LOD where can be 80-120%

Method name:
Method #: 3000
Matrix: Urine
Units: µg/L
Analyte:

Replicate
Spike 

concentration
Day 1 Day 2 Mean

Recovery 
(%)

Spike 
concentration

Day 1 Day 2 Mean
Recovery 

(%)
Mean 

recovery (%)
SD 
(%)

Sample 1 0 0 0 0
2 0 0 0 0 94.6 0.5
3 0 0.0 0.24 0.0

Sample + Spike 1 1 9 9.8 13 15
2 9.2 9.9 14 15
3 8.9 10 13 15

Sample + Spike 2 1 18 20 22 25
2 18 20 22 25
3 18 20 22 25

Sample + Spike 3 1 27 30 31 36
2 27 30 31 36
3 27 30 31 35

Sample 1
Measured concentration

0.0

9.5

19.0

29

94.7

95.0

0

10

20

30
95.0

Arsenic Speciation in Urine by ICP-DRC-MS-HPLC

35
33 95.1

15
14.2 94.2

25
23.5 93.8

Sample 2
Measured concentration

0
0.0

Trimethylarsine oxide (UTMO)
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Accuracy using Spike Recovery 
Recovery = (final concentration – initial concentration)/added concentration
Recovery should be 85-115% except at 3*LOD where can be 80-120%

Method name:
Method #: 3000
Matrix: Urine
Units: µg/L
Analyte:

Replicate
Spike 

concentration
Day 1 Day 2 Mean

Recovery 
(%)

Spike 
concentration

Day 1 Day 2 Mean
Recovery 

(%)
Mean 

recovery (%)
SD 
(%)

Sample 1 0 0 0 0
2 0.24 0 0 0 96.6 6.5
3 0 0.0 0.16 0.0

Sample + Spike 1 1 9.5 9.7 14 15
2 9.6 9.2 14 14
3 9.2 9.6 14 13

Sample + Spike 2 1 18 19 23 24
2 18 19 23 24
3 19 20 23 24

Sample + Spike 3 1 28 28 32 34
2 28 29 32 34
3 28 29 32 34

Sample 1
Measured concentration

0.0

9.5

18.8

28

94.3

94.0

0

10

20

30
94.3

Arsenic Speciation in Urine by ICP-DRC-MS-HPLC

30
33 109.9

15
14.0 93.2

25
23.5 93.9

Sample 2
Measured concentration

0
0.0

Arsenous (III) Acid (UAS3)
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Accuracy using Spike Recovery 
Recovery = (final concentration – initial concentration)/added concentration
Recovery should be 85-115% except at 3*LOD where can be 80-120%

Method name:
Method #: 3000
Matrix: Urine
Units: µg/L
Analyte:

Replicate
Spike 

concentration
Day 1 Day 2 Mean

Recovery 
(%)

Spike 
concentration

Day 1 Day 2 Mean
Recovery 

(%)
Mean 

recovery (%)
SD 
(%)

Sample 1 0 0.84 0 0.81
2 0 0.80 0 0.77 104.5 2.3
3 0 0.84 0 0.84

Sample + Spike 1 1 12 11 17 16
2 11 11 16 16
3 11 11 17 16

Sample + Spike 2 1 22 21 27 25
2 22 21 27 25
3 22 21 28 26

Sample + Spike 3 1 32 30 37 36
2 31 30 38 35
3 32 30 37 35

Arsenic Speciation in Urine by ICP-DRC-MS-HPLC

35
36 102.7

15
16.3 106.2

25
26.3 103.7

Sample 2
Measured concentration

0
0.4

Dimethylarsinic Acid (UDMA)

21.5

31

107.5

105.4

0

10

20

30
101.4

Sample 1
Measured concentration

0.4

11.2
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Accuracy using Spike Recovery
Recovery = (final concentration – initial concentration)/added concentration
Recovery should be 85-115% except at 3*LOD where can be 80-120%

Method name:
Method #: 3000
Matrix: Urine
Units: µg/L
Analyte: Monomethylarsonic Acid (UMMA)

Replicate
Spike 

concentration
Day 1 Day 2 Mean

Recovery 
(%)

Spike 
concentration

Day 1 Day 2 Mean
Recovery 

(%)
Mean 

recovery (%)
SD 
(%)

Sample 1 0 0 0 0
2 0 0 0 0 90.8 0.8
3 0 0.0 0 0.0

Sample + Spike 1 1 9.3 9.1 14 14
2 9.3 9 14 13
3 9.4 9 14 13

Sample + Spike 2 1 18 18 23 23
2 18 18 23 23
3 18 18 23 22

Sample + Spike 3 1 27 27 32 31
2 27 27 32 31
3 27 27 32 32

Arsenic Speciation in Urine by ICP-DRC-MS-HPLC

35
32 90.5

15
13.7 91.1

25
22.8 91.3

Sample 2
Measured concentration

0
0.0

18.0

27

91.8

90.0

0

10

20

30
90.0

Sample 1
Measured concentration

0.0

9.2
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Accuracy using Spike Recovery 
Recovery = (final concentration – initial concentration)/added concentration
Recovery should be 85-115% except at 3*LOD where can be 80-120%

Method name:
Method #: 3000
Matrix: Urine
Units: µg/L
Analyte:

Replicate
Spike 

concentration
Day 1 Day 2 Mean

Recovery 
(%)

Spike 
concentration

Day 1 Day 2 Mean
Recovery 

(%)
Mean 

recovery (%)
SD 
(%)

Sample 1 0 0.13 0 0.16
2 0 0.20 0 0.14 93.7 0.9
3 0 0.17 0 0.17

Sample + Spike 1 1 9.8 9.1 15 14
2 10 9.0 14 14
3 10 9.0 15 13

Sample + Spike 2 1 19 18 25 23
2 19 18 25 23
3 20 18 24 23

Sample + Spike 3 1 28 27 34 32
2 29 27 34 32
3 29 27 33 32

Sample 1
Measured concentration

0.1

9.5

18.7

28

94.0

92.9

0

10

20

30
92.5

Arsenic Speciation in Urine by ICP-DRC-MS-HPLC

35
33 93.6

15
14.2 93.9

25
23.8 95.0

Sample 2
Measured concentration

0
0.1

Arsenic (V) Acid (UAS5)
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Precision
Total relative standard deviation should be ≤ 15% (CV ≤ 15%)

Method name:
Method #: 3000
Matrix: Urine
Units: µg/L
Analyte:

Quality material 1
Run Result 1 Result 2 Mean SS 1 SS 2 2*mean^2
1 7.4 7.3 7.32 0.004244523 0.004244523 107.0550281
2 7.3 7.4 7.36 0.00662596 0.00662596 108.2862145
3 7.8 8.1 7.94 0.030572523 0.030572522 125.9586048
4 8.1 8.1 8.10 0.001524902 0.001524902 131.1665454
5 6.7 6.7 6.73 0.000254403 0.000254403 90.65176601
6 7.0 7.0 7.02 0.000167703 0.000167703 98.68579561
7 7.1 7.2 7.17 0.003642122 0.003642123 102.9339868
8 7.2 7.6 7.39 0.034614602 0.034614602 109.2788928
9 7.3 7.5 7.42 0.00599076 0.00599076 110.2167045
10 7.2 7.1 7.17 0.004699103 0.004699103 102.8020266

Grand sum 147.249 Grand mean 7.36245

Sum squares Mean Sq Error Std Dev
Rel Std Dev 

(%)
Within Run 0.1846732 0.01846732 0.135894518 1.85
Between Run 2.92216517 0.324685019 0.391291259 5.31
Total 3.10683837 0.414217539 5.63

Quality material 2
Run Result 1 Result 2 Mean SS 1 SS 2 2*mean^2
1 3.5 3.6 3.57 0.00046656 0.00046656 25.475522
2 3.6 3.4 3.51 0.008789063 0.008789063 24.65353981
3 3.9 4.0 3.93 0.003300502 0.003300503 30.89058601
4 4.0 4.1 4.05 0.00229441 0.00229441 32.75965568
5 3.4 3.1 3.22 0.019866902 0.019866903 20.68080985
6 3.2 3.0 3.09 0.00570025 0.00570025 19.0962
7 3.4 3.4 3.40 6.80625E-05 6.80625E-05 23.12748061
8 3.6 3.5 3.54 0.00552049 0.00552049 25.119872
9 3.6 3.7 3.64 0.00062001 0.00062001 26.4919205
10 3.6 3.5 3.53 0.000838103 0.000838103 24.94227821

Grand sum 70.9567 Grand mean 3.547835

Sum squares Mean Sq Error Std Dev Rel Std Dev 
Within Run 0.094928705 0.009492871 0.097431363 2.75
Between Run 1.4952009 0.166133433 0.279857609 7.89
Total 1.590129605 0.29633284 8.35

Arsenocholine (UASC)
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Urine arsenic speciation 
NHANES 2019-2020

78 of 101



 

Precision 
Total relative standard deviation should be ≤ 15% (CV ≤ 15%)

Method name:
Method #: 3000
Matrix: Urine
Units: µg/L
Analyte:

Quality material 1
Run Result 1 Result 2 Mean SS 1 SS 2 2*mean^2
1 43 42 42.32 0.321999503 0.321999503 3581.939408
2 42 42 42.09 0.00423801 0.00423801 3543.674972
3 43 44 43.24 0.23668225 0.23668225 3739.516273
4 45 44 44.41 0.075103403 0.075103403 3943.901128
5 41 41 41.23 0.00096721 0.00096721 3399.858784
6 45 43 43.78 0.522078502 0.522078503 3833.683266
7 45 45 44.67 0.01500625 0.01500625 3990.549785
8 39 41 40.22 1.36819809 1.36819809 3236.08516
9 44 44 44.37 0.009672723 0.009672722 3938.272375
10 45 43 43.81 1.204616003 1.204616003 3838.062691

Grand sum 860.2949 Grand mean 43.014745

Sum squares Mean Sq Error Std Dev
Rel Std Dev 

(%)
Within Run 7.517123885 0.751712389 0.867013488 2.02
Between Run 40.1780945 4.464232723 1.362446391 3.17
Total 47.69521839 1.614921842 3.75

Quality material 2
Run Result 1 Result 2 Mean SS 1 SS 2 2*mean^2
1 6.6 6.5 6.55 0.006947223 0.006947223 85.69368613
2 6.3 6.3 6.29 1.369E-05 1.369E-05 79.22383688
3 6.7 6.7 6.69 0.000225 0.000225 89.38112402
4 6.7 6.9 6.76 0.008602562 0.008602563 91.35329281
5 6.7 6.2 6.44 0.057384203 0.057384202 82.90727681
6 6.2 6.3 6.21 0.002185563 0.002185562 77.01770161
7 7.0 7.0 6.96 4.624E-05 4.624E-05 96.827528
8 6.1 5.9 6.00 0.017121723 0.017121722 71.91242665
9 7.0 7.1 7.03 0.000540563 0.000540563 98.76448513
10 7.1 7.2 7.15 0.001564203 0.001564203 102.2178318

Grand sum 132.1155 Grand mean 6.605775

Sum squares Mean Sq Error Std Dev Rel Std Dev 
Within Run 0.189261935 0.018926194 0.137572503 2.08
Between Run 2.573922803 0.285991423 0.365421147 5.53
Total 2.763184738 0.390459739 5.91

Arsenobetaine (UASB)

Arsenic Speciation in Urine by ICP-DRC-MS-HPLC

Urine arsenic speciation 
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Precision
Total relative standard deviation should be ≤ 15% (CV ≤ 15%)

Method name:
Method #: 3000
Matrix: Urine
Units: µg/L
Analyte:

Quality material 1
Run Result 1 Result 2 Mean SS 1 SS 2 2*mean^2
1 44 45 44.09 0.217575602 0.217575603 3888.729231
2 45 45 44.89 0.045646323 0.045646323 4030.915536
3 46 47 46.64 0.17073424 0.17073424 4350.859045
4 46 48 47.02 0.40755456 0.40755456 4422.061733
5 44 43 43.14 0.373137722 0.373137722 3721.644675
6 49 46 47.64 1.876763003 1.876763003 4539.301177
7 47 48 47.36 0.295990403 0.295990402 4485.153058
8 43 46 44.15 1.97993041 1.97993041 3899.13377
9 47 47 47.22 0.000241802 0.000241802 4459.50402
10 47 48 47.28 0.38489616 0.38489616 4471.685708

Grand sum 918.8894 Grand mean 45.94447

Sum squares Mean Sq Error Std Dev
Rel Std Dev 

(%)
Within Run 11.50494045 1.150494045 1.072610854 2.33
Between Run 51.10148239 5.677942488 1.504567786 3.27
Total 62.60642284 1.847760338 4.02

Quality material 2
Run Result 1 Result 2 Mean SS 1 SS 2 2*mean^2
1 6.8 6.7 6.72 0.001751423 0.001751422 90.18647905
2 6.9 6.7 6.78 0.00820836 0.00820836 91.8961245
3 7.7 7.3 7.49 0.02782224 0.02782224 112.2661217
4 7.4 7.8 7.60 0.02405601 0.02405601 115.51696
5 6.4 6.0 6.19 0.032815322 0.032815323 76.56660005
6 7.3 6.8 7.05 0.05326864 0.05326864 99.489618
7 7.3 7.2 7.22 0.00344569 0.00344569 104.3665729
8 6.4 6.4 6.39 0.000764523 0.000764522 81.58115113
9 7.0 6.9 6.98 0.003209223 0.003209222 97.49245885
10 7.6 7.8 7.69 0.011674802 0.011674803 118.3691138

Grand sum 140.2233 Grand mean 7.011165

Sum squares Mean Sq Error Std Dev Rel Std Dev 
Within Run 0.334032465 0.033403247 0.182765551 2.61
Between Run 4.602506841 0.511389649 0.488869309 6.97
Total 4.936539306 0.521916131 7.44

Trimethylarsine oxide (UTMO)

Arsenic Speciation in Urine by ICP-DRC-MS-HPLC

Urine arsenic speciation 
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Precision 
Total relative standard deviation should be ≤ 15% (CV ≤ 15%)

Method name:
Method #: 3000
Matrix: Urine
Units: µg/L
Analyte:

Quality material 1
Run Result 1 Result 2 Mean SS 1 SS 2 2*mean^2
1 7.2 7.3 7.22 0.00443556 0.00443556 104.3579045
2 6.8 6.8 6.76 0.00011025 0.00011025 91.43035538
3 6.7 7.3 6.97 0.094156922 0.094156922 97.07678461
4 6.7 7.3 6.96 0.087025 0.087025 96.8971205
5 6.5 6.4 6.43 0.000729 0.000729 82.66151042
6 6.7 6.5 6.60 0.01110916 0.01110916 87.04609568
7 7.2 7.5 7.34 0.013924 0.013924 107.8539845
8 6.3 6.9 6.60 0.074610923 0.074610923 87.05533201
9 6.6 6.6 6.62 0.000183603 0.000183603 87.76137613
10 7.1 7.1 7.09 9.604E-05 9.604E-05 100.5617256

Grand sum 137.1891 Grand mean 6.859455

Sum squares Mean Sq Error Std Dev
Rel Std Dev 

(%)
Within Run 0.572760915 0.057276092 0.239324239 3.49
Between Run 1.659731395 0.184414599 0.252129439 3.68
Total 2.23249231 0.347628171 5.07

Quality material 2
Run Result 1 Result 2 Mean SS 1 SS 2 2*mean^2
1 12 11 11.60 0.06105841 0.06105841 268.9761792
2 12 11 11.62 0.12131289 0.12131289 270.0395041
3 12 12 12.06 0.07941124 0.07941124 291.0705409
4 12 13 12.14 0.16459249 0.16459249 294.8174749
5 12 11 11.29 0.217156 0.217156 255.0004611
6 12 11 11.55 0.01679616 0.01679616 266.80962
7 12 12 12.35 0.00292681 0.00292681 305.1882768
8 12 11 11.34 0.02829124 0.02829124 257.1095585
9 11 12 11.44 0.060294802 0.060294802 261.8776322
10 13 13 12.95 0.085702562 0.085702562 335.283281

Grand sum 236.69 Grand mean 11.8345

Sum squares Mean Sq Error Std Dev Rel Std Dev 
Within Run 1.67508521 0.167508521 0.409278049 3.46
Between Run 5.06472379 0.562747088 0.444543905 3.76
Total 6.739809 0.604258061 5.11

Arsenous (III) Acid (UAS3)

Arsenic Speciation in Urine by ICP-DRC-MS-HPLC

Urine arsenic speciation 
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Precision 
Total relative standard deviation should be ≤ 15% (CV ≤ 15%)

Method name:
Method #: 3000
Matrix: Urine
Units: µg/L
Analyte:

Quality material 1
Run Result 1 Result 2 Mean SS 1 SS 2 2*mean^2
1 5.6 5.6 5.61 0.00031684 0.00031684 62.91727488
2 5.3 5.3 5.32 0.000499523 0.000499523 56.68888721
3 5.8 6.0 5.92 0.00900601 0.00900601 70.021778
4 5.6 6.1 5.85 0.06390784 0.06390784 68.48712648
5 5.2 5.1 5.16 0.004323063 0.004323062 53.18001581
6 5.0 4.9 4.91 0.002025 0.002025 48.30658632
7 5.8 5.7 5.74 0.00574564 0.00574564 65.97098978
8 5.1 5.6 5.35 0.047067302 0.047067302 57.30600625
9 5.6 5.6 5.63 4.2025E-06 4.2025E-06 63.48278521
10 5.6 5.6 5.60 0.000200222 0.000200223 62.80626965

Grand sum 110.2133 Grand mean 5.510665

Sum squares Mean Sq Error Std Dev
Rel Std Dev 

(%)
Within Run 0.266191285 0.026619128 0.163153696 2.96
Between Run 1.81914472 0.202127191 0.296233069 5.38
Total 2.085336005 0.338191011 6.14

Quality material 2
Run Result 1 Result 2 Mean SS 1 SS 2 2*mean^2
1 16 16 15.94 0.002688423 0.002688423 507.9281281
2 16 16 16.22 0.03591025 0.03591025 525.9367714
3 17 16 16.40 0.062675123 0.062675123 538.1135374
4 17 17 16.93 0.05909761 0.05909761 573.4665245
5 15 15 15.10 0.016448062 0.016448062 456.0049001
6 16 15 15.50 0.04414201 0.04414201 480.2582304
7 16 16 16.12 0.00446224 0.00446224 519.4638049
8 15 15 14.94 0.067210562 0.067210563 446.4579974
9 16 16 16.13 0.00804609 0.00804609 520.1409058
10 16 16 16.29 0.025520062 0.025520063 531.0051661

Grand sum 319.1251 Grand mean 15.956255

Sum squares Mean Sq Error Std Dev Rel Std Dev 
Within Run 0.652400865 0.065240087 0.25542139 1.60
Between Run 6.734493665 0.748277074 0.584395836 3.66
Total 7.38689453 0.637776278 4.00

Dimethylarsinic Acid (UDMA)

Arsenic Speciation in Urine by ICP-DRC-MS-HPLC

Urine arsenic speciation 
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Precision
Total relative standard deviation should be ≤ 15% (CV ≤ 15%)

Method name:
Method #: 3000
Matrix: Urine
Units: µg/L
Analyte:

Quality material 1
Run Result 1 Result 2 Mean SS 1 SS 2 2*mean^2
1 4.7 5.0 4.84 0.013398063 0.013398062 46.83280981
2 4.9 4.8 4.86 0.00398161 0.00398161 47.31504642
3 5.3 5.3 5.33 0.00029584 0.00029584 56.81140418
4 5.1 5.3 5.21 0.012667502 0.012667502 54.22465661
5 4.8 4.9 4.87 0.002308802 0.002308802 47.51857585
6 5.0 4.6 4.79 0.03976036 0.03976036 45.86521088
7 4.9 5.1 5.00 0.018782703 0.018782702 49.96300685
8 4.9 5.2 5.07 0.024009502 0.024009503 51.44529613
9 4.9 5.0 4.94 0.00801025 0.00801025 48.85463552
10 5.0 5.2 5.09 0.013653922 0.013653923 51.73987813

Grand sum 100.0026 Grand mean 5.00013

Sum squares Mean Sq Error Std Dev
Rel Std Dev 

(%)
Within Run 0.27373711 0.027373711 0.165450026 3.31
Between Run 0.544520012 0.060502224 0.1287022 2.57
Total 0.818257122 0.209613853 4.19

Quality material 2
Run Result 1 Result 2 Mean SS 1 SS 2 2*mean^2
1 10 10 10.01 0.022365203 0.022365202 200.5904351
2 10 9.5 9.85 0.12866569 0.12866569 193.9071245
3 11 10 10.41 0.08856576 0.08856576 216.5655096
4 10 11 10.39 0.01898884 0.01898884 215.7172205
5 9.5 9.0 9.25 0.08614225 0.08614225 171.236018
6 9.7 9.5 9.57 0.014125323 0.014125323 183.2559401
7 9.8 9.9 9.80 0.002204302 0.002204303 192.2466361
8 9.3 9.1 9.18 0.008454803 0.008454802 168.363085
9 9.7 9.5 9.60 0.01159929 0.01159929 184.1856245
10 9.7 11 10.20 0.25847056 0.25847056 208.2064992

Grand sum 196.5136 Grand mean 9.82568

Sum squares Mean Sq Error Std Dev Rel Std Dev 
Within Run 1.27916404 0.127916404 0.357654028 3.64
Between Run 3.394343472 0.377149275 0.353010531 3.59
Total 4.673507512 0.502526456 5.11

Monomethylarsonic Acid (UMMA)

Arsenic Speciation in Urine by ICP-DRC-MS-HPLC

Urine arsenic speciation 
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Precision 
Total relative standard deviation should be ≤ 15% (CV ≤ 15%)

Method name:
Method #: 3000
Matrix: Urine
Units: µg/L
Analyte:

Quality material 1
Run Result 1 Result 2 Mean SS 1 SS 2 2*mean^2
1 7.8 7.9 7.86 0.00314721 0.00314721 123.6315226
2 7.7 7.7 7.69 0.00128881 0.00128881 118.3706525
3 7.9 8.0 7.96 0.00380689 0.00380689 126.7518576
4 7.7 7.8 7.75 0.003335062 0.003335063 120.0800542
5 7.6 7.2 7.41 0.047982903 0.047982902 109.8680761
6 7.1 7.0 7.02 0.003969 0.003969 98.6029245
7 7.2 7.4 7.26 0.009321902 0.009321903 105.419556
8 7.5 8.0 7.76 0.04562496 0.04562496 120.5438645
9 7.6 7.6 7.59 5.29E-06 5.29E-06 115.0887233
10 7.7 7.9 7.80 0.006217323 0.006217323 121.68156

Grand sum 152.2154 Grand mean 7.61077

Sum squares Mean Sq Error Std Dev
Rel Std Dev 

(%)
Within Run 0.2493987 0.02493987 0.157923621 2.08
Between Run 1.562391482 0.173599054 0.272634539 3.58
Total 1.811790182 0.315070566 4.14

Quality material 2
Run Result 1 Result 2 Mean SS 1 SS 2 2*mean^2
1 13 13 12.69 0.00355216 0.00355216 322.1381914
2 12 12 12.44 0.00275625 0.00275625 309.6266355
3 13 13 12.93 0.01361889 0.01361889 334.5715384
4 12 13 12.83 0.162933322 0.162933323 329.0766851
5 12 12 11.93 0.00367236 0.00367236 284.8263914
6 12 12 11.88 0.10252804 0.10252804 282.4256378
7 13 13 12.65 0.008639703 0.008639703 319.9362192
8 12 12 12.19 0.036005063 0.036005063 297.2238948
9 13 12 12.40 0.05841889 0.05841889 307.6638568
10 13 13 12.75 0.01996569 0.01996569 325.0485045

Grand sum 249.4035 Grand mean 12.470175

Sum squares Mean Sq Error Std Dev Rel Std Dev 
Within Run 0.824180735 0.082418074 0.287085481 2.30
Between Run 2.432264403 0.2702516 0.30645842 2.46
Total 3.256445138 0.419922418 3.37

Arsenic (V) Acid (UAS5)

Arsenic Speciation in Urine by ICP-DRC-MS-HPLC

Urine arsenic speciation 
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Stability 

The initial measurement can be from the same day for all stability experiments.

Freeze and thaw stability = Assess for a minimum of 3 freeze-thaw cycles; conditions should mimic intended sample handling conditions
Describe condition: 2015 LU and HU samples three times frozen at approximately -80°C and then thawed (3 freeze-thaw cycles)
Bench-top stability = Assess short-term stability for length of time needed to handle study samples (typically at room temperature)
Describe condition: 2015 LU and HU QC original samples (not yet prepared for instrument analysis) stored at room temperature for 1 day
Processed sample stability = Assess short-term stability of processed samples, including resident time in autosampler
Describe condition: 2015 LU and HU QC samples processed samples (ready for instrument analysis) stored at room temperature for 1 day 
Long-term stability = Assess long-term stability that equals or exceeds time between date of first sample collection and date of last sample analysis
Describe condition: 2015 LU and HU bench QC samples stored at approximately -80°C for 2 years.

All stability sample results should be within ±15% of nominal concentration

Method name:
Method #: 3000
Matrix: Urine
Units: µg/L
Analyte:

Quality material 1
Initial 

measurement
Three freeze-
thaw cycles

Initial 
measurement

Bench-top 
stability

Initial 
measurement

Processed 
sample stability

Initial 
measurement

Long-term 
stability

Replicate 1 7.4 7.2 7.4 6.8 7.4 7.5 7.4 7.4
Replicate 2 7.6 6.7 7.6 6.8 7.6 7.7 7.3 7.9
Replicate 3 7.4 7.0 7.4 6.9 7.4 7.4 7.5 8.0

Mean 7.466666667 6.966666667 7.466666667 6.8 7.466666667 7.533333333 7.431666667 7.8
% difference from 
initial measurement

-- -6.7 -- -8.5 -- 0.9 -- 4.4

Quality material 2
Initial 

measurement
Three freeze-
thaw cycles

Initial 
measurement

Bench-top 
stability

Initial 
measurement

Processed 
sample stability

Initial 
measurement

Long-term 
stability

Replicate 1 3.3 3.7 3.3 3.4 3.3 3.5 3.5 3.5
Replicate 2 3.3 3.4 3.3 3.4 3.3 3.7 3.6 3.8
Replicate 3 3.4 3.4 3.4 3.4 3.4 3.7 3.6 3.9

Mean 3.333333333 3.5 3.333333333 3.4 3.333333333 3.633333333 3.571333333 3.7
% difference from 
initial measurement

-- 5.0 -- 2.0 -- 9.0 -- 4.1

Arsenocholine (UASC)

Arsenic Speciation in Urine by ICP-DRC-MS-HPLC

Urine arsenic speciation 
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Stability

The initial measurement can be from the same day for all stability experiments.

Freeze and thaw stability = Assess for a minimum of 3 freeze-thaw cycles; conditions should mimic intended sample handling conditions
Describe condition: 2015 LU and HU samples three times frozen at approximately -80°C and then thawed (3 freeze-thaw cycles)
Bench-top stability = Assess short-term stability for length of time needed to handle study samples (typically at room temperature)
Describe condition: 2015 LU and HU QC original samples (not yet prepared for instrument analysis) stored at room temperature for 1 day
Processed sample stability = Assess short-term stability of processed samples, including resident time in autosampler
Describe condition: 2015 LU and HU QC samples processed samples (ready for instrument analysis) stored at room temperature for 1 day 
Long-term stability = Assess long-term stability that equals or exceeds time between date of first sample collection and date of last sample analysis
Describe condition: 2015 LU and HU bench QC samples stored at approximately -80°C for 2 years.

All stability sample results should be within ±15% of nominal concentration

Method name:
Method #: 3000
Matrix: Urine
Units: µg/L
Analyte:

Quality material 1
Initial 

measurement
Three freeze-
thaw cycles

Initial 
measurement

Bench-top 
stability

Initial 
measurement

Processed 
sample stability

Initial 
measurement

Long-term 
stability

Replicate 1 43 40 43 39 43 41 43 42
Replicate 2 42 37 42 38 42 43 43 43
Replicate 3 43 38 43 39 43 41 45 43

Mean 42.66666667 38.33333333 42.66666667 38.7 42.66666667 41.66666667 43.55666378 42.8
% difference from 
initial measurement

-- -10.2 -- -9.4 -- -2.3 -- -1.7

Quality material 2
Initial 

measurement
Three freeze-
thaw cycles

Initial 
measurement

Bench-top 
stability

Initial 
measurement

Processed 
sample stability

Initial 
measurement

Long-term 
stability

Replicate 1 6.3 6.3 6.3 6.6 6.3 6.3 6.6 6.5
Replicate 2 6.5 6.4 6.5 6.7 6.5 6.4 6.7 6.7
Replicate 3 6.6 6.2 6.6 6.4 6.6 6.2 6.9 6.8

Mean 6.466666667 6.3 6.466666667 6.6 6.466666667 6.3 6.711298496 6.7
% difference from 
initial measurement

-- -2.6 -- 1.5 -- -2.6 -- -0.3

Arsenobetaine (UASB)

Arsenic Speciation in Urine by ICP-DRC-MS-HPLC

Urine arsenic speciation 
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Stability 

The initial measurement can be from the same day for all stability experiments.

Freeze and thaw stability = Assess for a minimum of 3 freeze-thaw cycles; conditions should mimic intended sample handling conditions
Describe condition: 2015 LU and HU samples three times frozen at approximately -80°C and then thawed (3 freeze-thaw cycles)
Bench-top stability = Assess short-term stability for length of time needed to handle study samples (typically at room temperature)
Describe condition: 2015 LU and HU QC original samples (not yet prepared for instrument analysis) stored at room temperature for 1 day
Processed sample stability = Assess short-term stability of processed samples, including resident time in autosampler
Describe condition: 2015 LU and HU QC samples processed samples (ready for instrument analysis) stored at room temperature for 1 day 
Long-term stability = Assess long-term stability that equals or exceeds time between date of first sample collection and date of last sample analysis
Describe condition: 2015 LU and HU bench QC samples stored at approximately -80°C for 2 years.

All stability sample results should be within ±15% of nominal concentration

Method name:
Method #: 3000
Matrix: Urine
Units: µg/L
Analyte:

Quality material 1
Initial 

measurement
Three freeze-
thaw cycles

Initial 
measurement

Bench-top 
stability

Initial 
measurement

Processed 
sample stability

Initial 
measurement

Long-term 
stability

Replicate 1 46 47 46 45 46 44 46 45
Replicate 2 45 41 45 42 45 46 46 45
Replicate 3 46 46 46 44 46 45 46 46

Mean 45.66666667 44.66666667 45.66666667 43.7 45.66666667 45 46.16774035 45.4
% difference from 
initial measurement

-- -2.2 -- -4.4 -- -1.5 -- -1.6

Quality material 2
Initial 

measurement
Three freeze-
thaw cycles

Initial 
measurement

Bench-top 
stability

Initial 
measurement

Processed 
sample stability

Initial 
measurement

Long-term 
stability

Replicate 1 6.6 7.0 6.6 6.7 6.6 6.8 7.1 6.6
Replicate 2 6.5 6.7 6.5 6.7 6.5 7.0 7.2 7.1
Replicate 3 6.7 7.3 6.7 6.8 6.7 6.9 7.2 6.9

Mean 6.6 7.0 6.6 6.7 6.6 6.9 7.152642946 6.9
% difference from 
initial measurement

-- 6.1 -- 2.0 -- 4.5 -- -4.1

Trimethylarsine oxide (UTMO)

Arsenic Speciation in Urine by ICP-DRC-MS-HPLC

Urine arsenic speciation 
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Stability 

The initial measurement can be from the same day for all stability experiments.

Freeze and thaw stability = Assess for a minimum of 3 freeze-thaw cycles; conditions should mimic intended sample handling conditions
Describe condition: 2015 LU and HU samples three times frozen at approximately -80°C and then thawed (3 freeze-thaw cycles)
Bench-top stability = Assess short-term stability for length of time needed to handle study samples (typically at room temperature)
Describe condition: 2015 LU and HU QC original samples (not yet prepared for instrument analysis) stored at room temperature for 1 day
Processed sample stability = Assess short-term stability of processed samples, including resident time in autosampler
Describe condition: 2015 LU and HU QC samples processed samples (ready for instrument analysis) stored at room temperature for 1 day 
Long-term stability = Assess long-term stability that equals or exceeds time between date of first sample collection and date of last sample analysis
Describe condition: 2015 LU and HU bench QC samples stored at approximately -80°C for 2 years.

All stability sample results should be within ±15% of nominal concentration

Method name:
Method #: 3000
Matrix: Urine
Units: µg/L
Analyte:

Quality material 1
Initial 

measurement
Three freeze-
thaw cycles

Initial 
measurement

Bench-top 
stability

Initial 
measurement

Processed 
sample stability

Initial 
measurement

Long-term 
stability

Replicate 1 7.3 7.9 7.3 7.2 7.3 7.2 7.0 6.9
Replicate 2 7.6 6.5 7.6 7.1 7.6 7.8 7.2 7.0
Replicate 3 7.6 7.6 7.6 6.9 7.6 7.1 7.2 7.3

Mean 7.5 7.333333333 7.5 7.1 7.5 7.366666667 7.137330742 7.1
% difference from 
initial measurement

-- -2.2 -- -5.8 -- -1.8 -- -1.1

Quality material 2
Initial 

measurement
Three freeze-
thaw cycles

Initial 
measurement

Bench-top 
stability

Initial 
measurement

Processed 
sample stability

Initial 
measurement

Long-term 
stability

Replicate 1 12 13 12 11 12 13 12 12
Replicate 2 13 13 13 11 13 12 12 12
Replicate 3 12 13 12 12 12 13 12 12

Mean 12.33333333 13.0 12.33333333 11.3 12.33333333 12.66666667 11.95737205 12.3
% difference from 
initial measurement

-- 5.4 -- -8.1 -- 2.7 -- 2.7

Arsenous (III) Acid (UAS3)

Arsenic Speciation in Urine by ICP-DRC-MS-HPLC

Urine arsenic speciation 
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Stability 

The initial measurement can be from the same day for all stability experiments.

Freeze and thaw stability = Assess for a minimum of 3 freeze-thaw cycles; conditions should mimic intended sample handling conditions
Describe condition: 2015 LU and HU samples three times frozen at approximately -80°C and then thawed (3 freeze-thaw cycles)
Bench-top stability = Assess short-term stability for length of time needed to handle study samples (typically at room temperature)
Describe condition: 2015 LU and HU QC original samples (not yet prepared for instrument analysis) stored at room temperature for 1 day
Processed sample stability = Assess short-term stability of processed samples, including resident time in autosampler
Describe condition: 2015 LU and HU QC samples processed samples (ready for instrument analysis) stored at room temperature for 1 day 
Long-term stability = Assess long-term stability that equals or exceeds time between date of first sample collection and date of last sample analysis
Describe condition: 2015 LU and HU bench QC samples stored at approximately -80°C for 2 years.

All stability sample results should be within ±15% of nominal concentration

Method name:
Method #: 3000
Matrix: Urine
Units: µg/L
Analyte:

Quality material 1
Initial 

measurement
Three freeze-
thaw cycles

Initial 
measurement

Bench-top 
stability

Initial 
measurement

Processed 
sample stability

Initial 
measurement

Long-term 
stability

Replicate 1 5.6 6.0 5.6 5.3 5.6 5.3 5.8 5.4
Replicate 2 5.6 5.4 5.6 5.2 5.6 5.8 5.6 5.4
Replicate 3 5.5 5.6 5.5 5.4 5.5 5.5 5.6 5.7

Mean 5.566666667 5.666666667 5.566666667 5.3 5.566666667 5.533333333 5.657992135 5.5
% difference from 
initial measurement

-- 1.8 -- -4.8 -- -0.6 -- -2.7

Quality material 2
Initial 

measurement
Three freeze-
thaw cycles

Initial 
measurement

Bench-top 
stability

Initial 
measurement

Processed 
sample stability

Initial 
measurement

Long-term 
stability

Replicate 1 17 17 17 16 17 17 16 16
Replicate 2 17 17 17 16 17 17 16 16
Replicate 3 16 17 16 16 16 17 16 16

Mean 16.66666667 17.0 16.66666667 16.0 16.66666667 17 16.24349934 16.0
% difference from 
initial measurement

-- 2.0 -- -4.0 -- 2.0 -- -1.5

Dimethylarsinic Acid (UDMA)
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Stability 

The initial measurement can be from the same day for all stability experiments.

Freeze and thaw stability = Assess for a minimum of 3 freeze-thaw cycles; conditions should mimic intended sample handling conditions
Describe condition: 2015 LU and HU samples three times frozen at approximately -80°C and then thawed (3 freeze-thaw cycles)
Bench-top stability = Assess short-term stability for length of time needed to handle study samples (typically at room temperature)
Describe condition: 2015 LU and HU QC original samples (not yet prepared for instrument analysis) stored at room temperature for 1 day
Processed sample stability = Assess short-term stability of processed samples, including resident time in autosampler
Describe condition: 2015 LU and HU QC samples processed samples (ready for instrument analysis) stored at room temperature for 1 day 
Long-term stability = Assess long-term stability that equals or exceeds time between date of first sample collection and date of last sample analysis
Describe condition: 2015 LU and HU bench QC samples stored at approximately -80°C for 2 years.

All stability sample results should be within ±15% of nominal concentration

Method name:
Method #: 3000
Matrix: Urine
Units: µg/L
Analyte: Monomethylarsonic Acid (UMMA)

Quality material 1
Initial 

measurement
Three freeze-
thaw cycles

Initial 
measurement

Bench-top 
stability

Initial 
measurement

Processed 
sample stability

Initial 
measurement

Long-term 
stability

Replicate 1 4.6 4.9 4.6 5.3 4.6 4.7 5.1 5.4
Replicate 2 4.4 4.5 4.4 5 4.4 4.6 4.9 5.4
Replicate 3 4.3 4.9 4.3 4.7 4.3 4.6 5.3 5.4

Mean 4.433333333 4.766666667 4.433333333 5.0 4.433333333 4.633333333 5.090569281 5.4
% difference from 
initial measurement

-- 7.5 -- 12.8 -- 4.5 -- 5.6

Quality material 2
Initial 

measurement
Three freeze-
thaw cycles

Initial 
measurement

Bench-top 
stability

Initial 
measurement

Processed 
sample stability

Initial 
measurement

Long-term 
stability

Replicate 1 9.1 10 9.1 9.6 9.1 9.8 10 11
Replicate 2 9.2 10 9.2 9.3 9.2 10 10 11
Replicate 3 9.4 10 9.4 9.5 9.4 9.8 10 11

9.683117293
Mean 9.233333333 10.0 9.233333333 9.5 9.233333333 9.866666667 10.05677324 10.7
% difference from 
initial measurement

-- 8.3 -- 2.5 -- 6.9 -- 6.1
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Stability 

The initial measurement can be from the same day for all stability experiments.

Freeze and thaw stability = Assess for a minimum of 3 freeze-thaw cycles; conditions should mimic intended sample handling conditions
Describe condition: 2015 LU and HU samples three times frozen at approximately -80°C and then thawed (3 freeze-thaw cycles)
Bench-top stability = Assess short-term stability for length of time needed to handle study samples (typically at room temperature)
Describe condition: 2015 LU and HU QC original samples (not yet prepared for instrument analysis) stored at room temperature for 1 day
Processed sample stability = Assess short-term stability of processed samples, including resident time in autosampler
Describe condition: 2015 LU and HU QC samples processed samples (ready for instrument analysis) stored at room temperature for 1 day 
Long-term stability = Assess long-term stability that equals or exceeds time between date of first sample collection and date of last sample analysis
Describe condition: 2015 LU and HU bench QC samples stored at approximately -80°C for 2 years.

All stability sample results should be within ±15% of nominal concentration

Method name:
Method #: 3000
Matrix: Urine
Units: µg/L
Analyte:

Quality material 1
Initial 

measurement
Three freeze-
thaw cycles

Initial 
measurement

Bench-top 
stability

Initial 
measurement

Processed 
sample stability

Initial 
measurement

Long-term 
stability

Replicate 1 7.4 7.2 7.4 7.1 7.4 7.1 7.8 7.2
Replicate 2 7.5 7.0 7.5 6.9 7.5 7.4 7.6 7.6
Replicate 3 7.3 6.9 7.3 7.6 7.3 7.1 7.9 7.7

Mean 7.4 7.033333333 7.4 7.2 7.4 7.2 7.789574431 7.5
% difference from 
initial measurement

-- -5.0 -- -2.7 -- -2.7 -- -3.7

Quality material 2
Initial 

measurement
Three freeze-
thaw cycles

Initial 
measurement

Bench-top 
stability

Initial 
measurement

Processed 
sample stability

Initial 
measurement

Long-term 
stability

Replicate 1 12 12 12 12 12 12 13 12
Replicate 2 13 12 13 12 13 13 13 13
Replicate 3 12 12 12 11 12 12 13 13

Mean 12.33333333 12.0 12.33333333 11.7 12.33333333 12.33333333 13.4042847 12.4
% difference from 
initial measurement

-- -2.7 -- -5.4 -- 0.0 -- -7.3

Arsenic (V) Acid (UAS5)
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LOD, specificity and fit for intended use

Method name:
Method #: 3000
Matrix: Urine
Units: µg/L

Analytes

Limit of Detection
(LOD)

Interferences 
successfully checked in 

at least 50 human 
samples

Accuracy, precision, LOD, 
specificity and stability meet 
performance specifications 

for intended use

Arsenocholine 0.11 yes yes
Arsenobetaine 1.16 yes yes
Trimethylarsine oxide 0.17 yes yes
Arsenous (III) Acid 0.12 yes yes
Dimethylarsinic Acid 1.91 yes yes
Monomethylarsonic Acid 0.2 yes yes
Arsenic (V) Acid 0.79 yes yes
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b. Appendix B:  Ruggedness Testing 

Critical Parameter Test 1: This test evaluated the significance of the column oven temperature 
while analyzing urine samples for seven arsenic species (AC, AB, TMAO, AsIII, DMA, MMA, and 
AsV). The column oven temperature was increased and decreased by 10°C increments (roughly 
28.5%). The results are presented in the table below.  
 
Test Details: 
1. Prepare a set of samples for analysis in triplicate (seven separate vials of low bench QC, each 
prepared in triplicate). 
2.  Analyze the samples along with calibrators and QC as normal. 
3.  Analyze the same samples again at 25°C on day two and at 35°C on day three. 
 

Critical Test Parameter 1. Ruggedness Testing Results:  Evaluating the significance of 
column oven temperature on sample stability.  Tests performed on March 21, 2013, March 22, 
2013, and March 25, 2013 by Joshua Godshaw.  Results below are the average of the 21 
replicates of the low bench QC analyzed as samples in each run (in µg/L). 

Analyte 
Target Mean 

and 2SD 
Range  

25°C 
(decreased) 

35°C 
(per method) 

45°C 
(increased) 

AC 7.59 
6.83 – 8.35 

7.06 
6.83 – 7.30 

7.44 
7.06 - 7.81 

6.87 
6.42 – 7.33 

AB 24.07 
21.79 – 26.35 

24.7 
23.68 – 25.72 

24.01 
23.24 – 24.78 

25.2 
23.43 - 26.97 

TMAO 32.25 
30.55 – 33.95 

32.15 
31.50 – 33.25 

31.95 
31.01 – 32.90 

31.87 
29.93 – 33.83 

AsIII 7.10 
6.32 – 7.88 

7.13 
6.25 – 8.00 

7.18 
6.48 – 7.87 

7.49 
6.60 – 8.39 

DMA 3.97 
3.34 – 4.39 

3.88  
3.65 – 4.12 

3.80 
3.58 - 4.01  

3.71 
3.37 – 4.05 

MMA 4.46 
3.94 – 4.97 

4.24 
4.10 – 4.38 

4.52 
4.33 – 4.71 

4.23  
3.98 – 4.49 

AsV 7.98 
6.92 – 9.04 

7.42 
6.85 – 7.99 

7.20 
6.54 - 7.86 

7.24  
6.54 – 7.95 

 
Conclusion: All of the analytes fell within 2SD of the mean at all temperatures; however, it was 
confirmed that the column oven temperature of 35°C was the optimal choice due to the 
sharpness of the peaks (no tailing, etc.) obtained at that temperature. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Critical Parameter Test 2: This test evaluated the significance of the concentration of ammonium 
acetate in the diluent on quality control sample recovery. The amount of ammonium acetate in the 
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diluent was increased and decreased by 0.025M increments (roughly 25%). The results are 
presented in the table below.  
 
Test Details: 
1. Prepare three sets of samples for analysis in triplicate (seven separate vials of low bench QC, 
each prepared in triplicate) for each of the three concentrations. 
2.  Analyze the samples along with calibrators and QC as normal. 
 

Critical Parameter Test 2. Ruggedness Testing Results:  Evaluating the significance of the 
concentration of ammonium acetate in the diluent on quality control sample recovery.  Tests 
performed on April 03, 2013, April 04, 2013, and April 08, 2013 by Joshua Godshaw.  Results 
below are the average of the 21 replicates of the low bench QC analyzed as samples in each 
run (in µg/L). 

Analyte 
Target Mean 

and 2SD 
Range  

0.075M 
(decreased) 

0.1M 
 (per method) 

0.125M 
 (increased) 

AC 7.59 
6.83 – 8.35 

6.76 
6.42 – 7.09 

7.30 
6.82 – 7.79 

7.40 
7.15 – 7.66 

AB 24.07 
21.79 – 26.35 

24.55 
23.74 – 25.35 

24.92 
23.89 – 25.95 

25.43 
24.77 – 26.09 

TMAO 32.25 
30.55 – 33.95 

31.19 
30.00 – 32.39 

32.34 
31.32 – 33.36 

32.51 
31.88 – 33.14 

AsIII 7.10 
6.32 – 7.88 

6.91 
6.33 – 7.48 

6.91 
6.25 – 7.57 

6.90 
6.35 – 7.45 

DMA 3.97 
3.34 – 4.39 

3.95 
3.66 – 4.24 

3.81 
3.52 – 4.10 

3.82  
3.56– 4.08 

MMA 4.46 
3.94 – 4.97 

4.28 
4.01 – 4.54 

4.50 
4.22 – 4.79 

4.72 
4.60 – 4.85 

AsV 7.98 
6.92 – 9.04 

7.33 
6.55 – 8.11 

7.96 
7.41 – 8.51 

7.91 
7.35 – 8.46 

 
Conclusion:  Results using 0.1M ammonium acetate in the diluent and results using 0.125M 
ammonium acetate in the diluent all fell within 2 SD of the mean. A concentration of 0.075M 
ammonium acetate produced QC results outside of the mean for arsenocholine. 0.1M was 
confirmed to be the optimum ammonium acetate diluent concentration. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Critical Parameter Test 3: This test evaluated the significance of the dynamic reaction cell 
(DRC™) gas flow rate on quality control sample recovery while analyzing urine samples for 
arsenic species. On the instrument used, the normal cell gas flow rate is 0.6 mL/min. The DRC™ 
cell gas flow rate was increased and decreased by 0.12 increments (20%) giving reduced and 
elevated settings of 0.48 mL/min and 0.72 mL/min, respectively. The results are presented in the 
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table below.  
 
Test Details: 
1. Prepare a set of samples for analysis in triplicate (three separate vials of low bench QC, each 
prepared in triplicate). 
2.  Analyze the samples along with calibrators and QC with a cell gas flow of 0.55 mL/min (per 
method) on day one. 
3.  Analyze the same samples again with a cell gas flow of 0.44 mL/min on day two and 0.66 
mL/min on day three. 
 

Critical Parameter Test 3. Ruggedness Testing Results:  Evaluating the significance of 
dynamic reaction cell gas flow rate on quality control sample stability.  Tests performed on 
March 26, 2013, March 27, 2013, and March 29, 2013 by Joshua Godshaw.  Results below 
are the average of the 9 replicates of the low bench QC analyzed as samples in each run (in 
µg/L). 

Analyte 
Target Mean 

and 2SD 
Range  

0.44 mL/min 
(decreased) 

0.55 mL/min 
 (per method) 

0.66 mL/min 
 (increased) 

AC 7.59 
6.83 – 8.35 

7.82 
7.32 – 8.32 

7.68 
7.05 – 8.31 

7.83 
7.26 – 8.39 

AB 24.07 
21.79 – 26.35 

24.03 
23.15 – 24.91 

25.85 
25.23 - 26.46 

24.61 
23.64 – 25.58 

TMAO 32.25 
30.55 – 33.95 

30.90 
29.94 – 31.85 

33.14 
32.18 – 34. 10 

32.29 
31.63 – 32.95 

AsIII 7.10 
6.32 – 7.88 

7.12 
6.52 – 7.88 

7.38 
6.63 – 8.13 

7.67 
7.05 – 8.29 

DMA 3.97 
3.34 – 4.39 

3.93 
3.63 – 4.24 

4.02 
3.71 – 4.33 

4.42 
4.13 – 4.71 

MMA 4.46 
3.94 – 4.97 

4.29 
4.08 – 4.49 

4.40 
4.25 – 4.56 

4.67 
4.51 – 4.82 

AsV 7.98 
6.92 – 9.04 

7.45 
6.75 - 8.14 

7.83 
7.22 – 8.44 

7.92 
7.32 – 8.51 

 
Conclusion: A DRC gas flow of 0.44 mL/min produced some results that were close to being 
outside of 2SD, and 0.66 mL/min produced DMA results that were outside of 2 SD. A DRC gas 
flow of 0.55 mL/min was confirmed to be the optimum choice. 
 
 
 
 
 
 
 
 
 
 
 
Critical Parameter Test 4: This test evaluated the significance of the pH of buffer B on while 
analyzing urine quality control samples for seven arsenic species. The pH of the buffer was 
increased and decreased by 1.6 increments (20%). The results are presented in the table below. 
  
Test Details: 
1. Prepare a set of samples for analysis in triplicate (seven separate vials of low bench QC, each 
prepared in triplicate). 
2.  Analyze the samples along with calibrators and QC as normal. 
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3.  Analyze the same samples again at a buffer B pH of 6.4 on day two and at a buffer B pH of 
9.6 on day three. 
 

Critical Parameter Test 4. Ruggedness Testing Results:  Evaluating the significance of the 
pH of buffer B on quality control sample stability.  Tests performed on April 10, 2013, April 11, 
2013, and April 12, 2013 by Joshua Godshaw.  Results below are the average of the 21 
replicates of the low bench QC analyzed as samples in each run (in µg/L). 

Analyte 
Target Mean 

and 2SD 
Range  

6.4 
(decreased) 

8.0 
(per method) 

9.6 
(increased) 

AC 7.59 
6.83 – 8.35 

7.30 
7.03 – 7.57 

6.94 
6.23 – 7.64 

6.99 
6.68 – 7.30 

AB 24.07 
21.79 – 26.35 

24.60 
23.67 – 25.52 

25.32 
24.71 – 25.93 

22.40 
21.11 – 23.69 

TMAO 32.25 
30.55 – 33.95 

31.27 
30.38 – 32.16 

31.57 
 30.88 – 32.25 

29.08  
27.60 – 30.56 

AsIII 7.10 
6.32 – 7.88 

6.92 
6.38 – 7.46 

7.12 
6.49 – 7.75 

6.28 
5.78 – 6.78 

DMA 3.97 
3.34 – 4.39 

3.69 
3.39 – 3.98 

3.83 
3.49 – 4.16 

3.36 
3.11 – 3.61 

MMA 4.46 
3.94 – 4.97 

4.24 
3.99 – 4.49 

4.36  
4.14 – 4.58 

3.32 
2.99 – 3.64 

AsV 7.98 
6.92 – 9.04 

7.26 
6.78 – 7.73 

7.92 
7.46 – 8.39 

5.56 
4.64 – 6.49 

 
Conclusion: A buffer B pH of 9.6 produced some values outside of 2 SD for all of the analytes that 
elute while buffer B is flowing through the system. A pH of 8.0 for buffer B was confirmed to be 
optimal for this method. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Critical Parameter Test 5: This test evaluated the significance of the RPq on quality control 
sample recovery while analyzing urine samples for arsenic species. On the instrument used, the 
normal RPq is 0.5. The RPq was increased and decreased by 0.1 increments (20%) giving 
reduced and elevated settings of 0.4 and 0.6, respectively. The results are presented in the table 
below.  
 
Test Details: 
1. Prepare a set of samples for analysis in triplicate (seven separate vials of low bench QC, each 
prepared in triplicate). 
2.  Analyze the samples along with calibrators and QC with a RPq of 0.5 (per method) on day 
one. 
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3.  Analyze the same samples again with a RPq of 0.4 on day two and 0.6 on day three. 
 

Critical Parameter Test 5. Ruggedness Testing Results:  Evaluating the significance of RPq 
on quality control sample stability.  Tests performed on June 03, 2013, June 04, 2013, and 
June 05, 2013 by Jennifer Ysseldyke.  Results below are the average of the 21 replicates of 
the low bench QC analyzed as samples in each run (in µg/L). 

Analyte 
Target Mean 

and 2SD 
Range  

0.4 
(decreased) 

0.5 
(per method) 

0.6 
(increased) 

AC 7.59 
6.83 – 8.35 

7.72 
6.91 – 8.53 

6.53 
5.79 – 7.27 

6.91 
6.36 – 7.45 

AB 24.07 
21.79 – 26.35 

27.49 
25.49 – 29.48 

24.65 
22.57 – 26.73 

25.31 
21.96 -28.66 

TMAO 32.25 
30.55 – 33.95 

33.84 
31.58 – 36.10 

32.25 
29.81 – 34.69 

33.90 
31.19 – 36.61 

AsIII 7.10 
6.32 – 7.88 

8.21 
7.28 - 9.14 

6.91 
6.10 - 7.72 

7.38 
6.75 - 8.01 

DMA 3.97 
3.34 – 4.39 

4.55 
4.08 – 5.03 

3.49 
3.03 – 3.94 

3.63 
3.38 - 3.89 

MMA 4.46 
3.94 – 4.97 

4.99 
4.31 – 5.66 

4.01 
3.65 – 4.36 

4.20 
3.85 – 4.56 

AsV 7.98 
6.92 – 9.04 

8.16 
6.87 – 9.45 

7.27 
6.19 – 8.34 

7.25 
6.34 – 8.16 

 
 
Conclusion: A RPq of 0.5 mL was confirmed to be the optimal RPq for this method.  The failure 
for AC was an anomaly.   
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c. Appendix C: Sample Chromatographic Report 

Example chromatogram of a bench QC sample below:  
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d. Appendix D: HPLC Batch Run “Results” File in Microsoft Excel® 

A screen shot of a "results” file in Microsoft Excel® after exporting data with Empower Quickstart. 
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e. Appendix E: Empower Troubleshooting 

1) There is a communication issue if the instrument control panels are not “blinking” in 
Empower or the instrument status of the “Nexion-300 ICP-MS” reads anything but “Idle”.  
Go through the following procedure to correct the issue. 

a. Close all Empower windows. 
b. Ctrl + Alt + Del and open the “Task Manager”.  Go the “Process” tab and scroll to 

“Instrument Server.exe”.  Right click and select “End Process”. 
c. Go to the switching valves and power them on/off by unplugging/replugging in 

the power cords to both valves. 
d. Reopen Empower. 

2) If the above does not fix communication between all of the components close Empower.  
Then power off/on the “Instrument” toggle on the NexION.  Reopen Empower. 

3) If you are prompted with an error “Out of Memory” complete the following step. 
a. In the Empower window click on the “Configure the System”. 
b. On the left-hand side of the window that opens click on Project” to open the drop-

down folders. 
c. Highlight your Project folder and right click.  Select “Properties”. 
d. On the bottom of the window will be a section for database memory.  Increase 

the MB of memory for the folder by 100.  Close the window. 
e. Close all Empower windows and reopen so the changes are applied. 
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